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Data Acquisition and Processing Report

NOAA Ship Thomas Jefferson
Chief of Party: Shepard Smith, Capt, NOAA

Year: 2015
Version: 1

Publish Date: 2015-10-01

A Equipment

A.1 Survey Vessels

A.1.1 NOAA Ship Thomas Jefferson (WTEA)

Name NOAA Ship Thomas Jefferson (WTEA)

Hull Number S-222

Description
NOAA Ship Thomas Jefferson is a steel hulled hydrographic survey ship built by
 Halter Marine, Inc, Moss Point, MS. 

Utilization
The primary mission of “NOAA Ship Thomas Jefferson” is to acquire hydrographic
 survey data to update NOAA nautical charts. Based on current draft and sonar
 configuration, the ship can operate in waters between 30 feet and 656 feet deep.

Dimensions

LOA 208 feet

Beam 45 feet

Max Draft 17 feet

Most Recent Full
Static Survey

Full static survey was not performed.
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Most Recent Partial
Static Survey

Date 2014-02-14

Performed By National Geodetic Survey

Discussion

The Thomas Jefferson has never had
a full static survey that includes all
current antennas, inertial motion units,
sonars and towpoints. Instead a series
of partial surveys have been conducted
across several years. In 2001 a survey
of the (then named) USNS Littlehales
was conducted by National Aeronautics
and Space Administration (NASA).
The survey measured offsets to several
antennas and sonars, and established
several benchmarks. Though the
antennae and sonars are now defunct,the
benchmarks are still in use. In 2003
a survey was conducted by the ship's
force to establish the location of the
DGPS antennae and the side scan
sonar towpoint. In 2005 a survey was
conducted by NOAA's National Geodetic
Survey (NGS). This survey verified the
placement of the POS M/V IMU and
antennas. Several additional permanent
benchmarks were also established.
In 2006 NGS conducted a survey to
include the new RESON 7125 Multibeam
Echosounder into the vessel's reference
frame. In 2014, a new Reson 7125-SV2
and Sutron bubbler (for ship's static draft)
were mounted to the hull of the ship.
NGS conducted a partial offset survey to
bring the new equipment into the vessel's
reference frame.

Most Recent Full
Offset Verification

Full offset verification was not performed.
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Most Recent Partial
Offset Verification

Date 2015-04-20

Method Used Shipboard Analysis

Discussion

A verification of the ships offsets was
performed by HSTP personnel. The
analysis used up to date rotational
software for each of the axis orientations
required by the major components of
sensor software, specifically Caris,
Applanix, and Reson. The data was
from the last survey of the ship in 2014.
The new rotations produce some small
changes in offsets.

Most Recent Static
Draft Determination

Date 2015-04-18

Method Used Bubbler and Ellipsoid

Discussion

Static draft was performed by use
of a Sutron bubbler gauge installed
in the proximity of the IMU. Recent
adjustments to the Sutron field
calibrations were performed so that
waterline can be directly measured by the
sensor. An ERS ellipsoid static draft was
also performed to confirm these values.

Most Recent
Dynamic Draft
Determination

Date 2015-04-27

Method Used Ellipsoidally Referenced Dynamic Draft

Discussion

Dynamic draft was determined using
the Ellipsoidally Referenced Dynamic
Draft Model (ERDDM). Acquisition and
processing was done in accordance with
FPM Section 1.4.2.1.2.1 via the Pydro
macro ProcSBETDynamicDraft.py.
Ellipsoid heights were obtained via the
5P method, described in Section B.2.4.
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Figure : NOAA Ship Thomas Jefferson (WTEA)

A.1.2 Hydrographic Survey Launch 3101 (TJ3101)

Name Hydrographic Survey Launch 3101 (TJ3101)

Hull Number 3101

Description TJ3101 is an aluminum hulled hydrographic survey launch. 

Utilization
TJ3101 is equipped to collect bathymetric data, side scan imagery, and water column
 profiles. It can operate in waters between 12 feet and 656 feet deep.

Dimensions

LOA 31 feet

Beam 10.6 feet

Max Draft 5.16 feet
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Most Recent Full
Static Survey

Date 2015-04-02

Performed By National Geodetic Survey personnel

Discussion

A full survey of launch offsets was
performed in April 2014 by NGS
personnel while acquiring POSPac
data. Side scan sonar offsets were not
measured at the same time, as the SSS
can only be mounted when the launch
is in the davits, not on jacks. Receiver
to projector offsets were obtained by
hand and entered into the Reson units’
hardware menu.

Most Recent Partial
Static Survey

Partial static survey was not performed.

Most Recent Full
Offset Verification

Full offset verification was not performed.

Most Recent Partial
Offset Verification

Partial offset verification was not performed.

Most Recent Static
Draft Determination

Date 2015-04-28

Method Used Site Tube

Discussion

Static draft is measured on a daily basis
via a sight tube located near the IMU.
Measurements were conducted using a
steel ruler.

Most Recent
Dynamic Draft
Determination

Date 2015-05-28

Method Used Ellipsoidally Referenced Dynamic Draft

Discussion

Dynamic draft was determined using
the Ellipsoidally Referenced Dynamic
Draft Model (ERDDM). Acquisition and
processing was done in accordance with
FPM Section 1.4.2.1.2.1 via the Pydro
macro ProcSBETDynamicDraft.py.
Ellipsoid heights were obtained via the
5P method, described in Section B.2.4.
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Figure : 3101

A.1.3 Hydrographic Survey Launch 3102 (TJ3102)

Name Hydrographic Survey Launch 3102 (TJ3102)

Hull Number 3102

Description TJ3102 is an aluminum hulled hydrographic survey launch. 

Utilization
TJ3102 is equipped to collect bathymetric data, side scan imagery, and water column
 profiles. It can operate in waters between 12 feet and 656 feet deep.

Dimensions

LOA 31 feet

Beam 10.6 feet

Max Draft 5.16 feet
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Most Recent Full
Static Survey

Date 2015-04-02

Performed By National Geodetic Survey personnel

Discussion

A full survey of launch offsets was
performed in April 2014 by NGS
personnel while acquiring POSPac
data. Side scan sonar offsets were not
measured at the same time, as the SSS
can only be mounted when the launch
is in the davits, not on jacks. Receiver
to projector offsets were obtained by
hand and entered into the Reson units’
hardware menu.

Most Recent Partial
Static Survey

Partial static survey was not performed.

Most Recent Full
Offset Verification

Full offset verification was not performed.

Most Recent Partial
Offset Verification

Partial offset verification was not performed.

Most Recent Static
Draft Determination

Date 2015-04-28

Method Used Sight Tube

Discussion

Static draft is measured on a daily basis
via a sight tube located near the IMU.
Measurements were conducted using a
steel ruler.

Most Recent
Dynamic Draft
Determination

Date 2015-04-28

Method Used Ellipsoidally Referenced Dynamic Draft

Discussion

Dynamic draft was determined using
the Ellipsoidally Referenced Dynamic
Draft Model (ERDDM). Acquisition and
processing was done in accordance with
FPM Section 1.4.2.1.2.1 via the Pydro
macro ProcSBETDynamicDraft.py.
Ellipsoid heights were obtained via the
5P method, described in Section B.2.4.
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Figure : 3102

A.1.4 Z-Boat 1

Name Z-Boat 1

Hull Number Z-1

Description Z-1 is a 5.5' polyurethane autonomous survey vessel. 

Utilization
The vessel is used to conduct Vertical Beam Echo Sounder (VBES) soundings in
 shallow areas, as well as to conduct shoreline verification.

Dimensions

LOA 5.5 feet

Beam 2 feet

Max Draft 1 feet

Most Recent Full
Static Survey

Full static survey was not performed.
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Most Recent Partial
Static Survey

Date 2015-07-14

Performed By Ship's force

Discussion

Measurements were conducted using
a steel tape and laser rangefinders to
determine the distance from the primary
GPS antenna to the sounder face.

Most Recent Full
Offset Verification

Full offset verification was not performed.

Most Recent Partial
Offset Verification

Partial offset verification was not performed.

Most Recent Static
Draft Determination

Date 2015-08-19

Method Used Direct Observation

Discussion

The boat was placed in the water with a
full operational load. Waterline readings
were then taken using marks made on
the side of the hull indicating a distance
above the transducer zero point.

Most Recent
Dynamic Draft
Determination

Date 2015-08-19

Method Used Comparitive

Discussion

Dynamic Draft for the Z-Boats was
measured by acquiring VBES data over
the same area twice on reciprocal courses
at the following speed intervals: Hove
To (0 knots) 1 knot 2 knots 3 knots 3.5
knots 4 knots 4.5 knots 5 knots 6 knots
The purpose for the stated speed intervals
was to capture draft at various expected
survey speeds.
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Figure : Z-Boat 1 (Z-1)

A.1.5 Z-Boat 2

Name Z-Boat 2

Hull Number Z-2

Description Z-2 is a 5.5' polyurethane autonomous survey vessel. 

Utilization
The vessel is used to conduct Vertical Beam Echo Sounder (VBES) soundings in
 shallow areas, as well as to conduct shoreline verification.

Dimensions

LOA 5.5 feet

Beam 2 feet

Max Draft 1 feet

Most Recent Full
Static Survey

Full static survey was not performed.
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Most Recent Partial
Static Survey

Date 2015-08-17

Performed By Ship's Force

Discussion

Measurements were conducted using
a steel tape and laser rangefinders to
determine the distance from the primary
GPS antenna to the sounder face.

Most Recent Full
Offset Verification

Date 2015-08-17

Method Used Direct measurement

Discussion

Measurements were conducted using
a steel tape and laser rangefinders to
determine the distance from the primary
GPS antenna to the sounder face.

Most Recent Partial
Offset Verification

Partial offset verification was not performed.

Most Recent Static
Draft Determination

Date 2015-08-19

Method Used Direct observation

Discussion

The boat was placed in the water with a
full operational load. Waterline readings
were then taken using marks made on
the side of the hull indicating a distance
above the transducer zero point.

Most Recent
Dynamic Draft
Determination

Date 2015-08-19

Method Used Comparitive

Discussion

Dynamic Draft for the Z-Boats was
measured by acquiring VBES data over
the same area twice on reciprocal courses
at the following speed intervals: Hove
To (0 knots) 1 knot 2 knots 3 knots 3.5
knots 4 knots 4.5 knots 5 knots 6 knots
The purpose for the stated speed intervals
was to capture draft at various expected
survey speeds.
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Figure : Z-Boat 2

A.2 Echo Sounding Equipment

A.2.1 Side Scan Sonars

A.2.1.1 Klein 5000

Manufacturer Klein

Model 5000

Description
The Klein High Speed, High Resolution Side Scan Sonar (SSS) system is a beam-
forming acoustic imagery device. The integrated system includes a Klein 5000 towfish, a
 Transceiver/Processing Unit (TPU), and a computer for user interface. Stern-towed units
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 also include a tow cable telemetry assembly. The towfish operates at frequency of 455kHz
 and a vertical beam angle of 40°, and can resolve up to 5 discrete received beams per
 transducer stave. There are two configurations for data acquisition using the Klein 5000
 system: stern-towed and hull-mounted. “Thomas Jefferson” uses exclusively stern towed
 SSS. TJ3101 uses a hull-mount configuration. TJ3102 can be converted from hull-mounted
 to towed as required. There are also two options for the weight of the towfish: the standard,
 and a lightweight variant. The hull mounts on both survey launches can accommodate both
 standard or lightweight towfish. “Thomas Jefferson” can only use the standard weight. 

Positioning of the Towfish is calculated using Caris SIPS, and is derived from the amount
 of cable out, the towfish depth (from the towfish pressure gauge), the vessel's Course Made
 Good (CMG), and the vessel's heading. Towfish altitude is maintained between 8% and
 20% of the range scale unless specifically noted in the Descriptive Report. Vessel speed is
 adjusted during SSS acquisition to ensure that object detection density is met. Confidence
 checks are performed by noting changes in linear bottom features extending to the outer
 edges of the digital side scan image, and by verifying aids to navigation or other known
 features on the side scan record.  

Serial
Numbers

Vessel Installed

On
"Thomas Jefferson" TJ3101 TJ3102

TPU s/n 137 139 135

Towfish s/n 280 320 322

Specifications

Frequency 455 kilohertz

Along Track
Resolution

Resolution 10  centimeters 20  centimeters 36  centimeters

Min Range 0 meters 39 meters 75 meters

Max Range 38 meters 76 meters 150 meters

Across Track
Resolution

3.75 centimeters

Max Range
Scale

150 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.
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Figure : Klein 5000 Side Scan Sonar towfish

A.2.1.2 Klein 5000 V2

Manufacturer Klein

Model 5000 V2

Description

The Klein High Speed, High Resolution Multi-Beam Side Scan Sonar (SSS) system is
 a beam-forming acoustic imagery device. The integrated system includes a Klein 5000
 towfish, a Transceiver/Processing Unit (TPU), and a computer for user interface. Stern-
towed units also include a tow cable telemetry assembly. The towfish operates at a frequency
 of 455kHz and a vertical beam angle of 40°, and can resolve up to 5 discrete received beams
 per transducer stave. The system is capable of ranges up to 250 meters, however “Thomas
 Jefferson” does not use the 150m or the 250m reconnaissance mode. In addition, the Klein
 5000 V2 model can collect bathymetric information using phase differencing. Each side
 scan transducer stave contains 3 bathymetry staves. The bathymetry staves operate at
 455kHz, with an along track resolution of 0.4°, and can resolve one discrete beam per side.
 “Thomas Jefferson” operates the Klein 5000 as a stern-towed unit, and does not process or
 use the collected bathymetric data.

Positioning of the Towfish is calculated using Caris SIPS, and is derived from the amount
 of cable out, the towfish depth (from the towfish pressure gauge), the vessel's Course Made
 Good (CMG), and the vessel's heading. Towfish altitude is maintained between 8% and
 20% of the range scale unless specifically noted in the Descriptive Report. Vessel speed is
 adjusted during SSS acquisition to ensure that object detection density is met. Confidence
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 checks are performed by noting changes in linear bottom features extending to the outer
 edges of the digital side scan image, and by verifying aids to navigation or other known
 features on the side scan record. 

Serial
Numbers

Vessel Installed

On
"Thomas Jefferson"

TPU s/n 778

Towfish s/n 385

Specifications

Frequency 455 kilohertz

Along Track
Resolution

Resolution 10  centimeters 20  centimeters 36  centimeters

Min Range 0 meters 39 meters 76 meters

Max Range 38 meters 75 meters 150 meters

Across Track
Resolution

3.75 centimeters

Max Range
Scale

150 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.
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Figure : Klein 5000 V2

A.2.2 Multibeam Echosounders

A.2.2.1 Reson SeaBat 7125-ROV

Manufacturer Reson

Model SeaBat 7125-ROV

Description

The Reson SeaBat 7125-ROV system is a single-frequency multibeam echo sounder.
 It is hull mounted on “Thomas Jefferson.” The integrated system includes a 400
 kHz Projector unit, a Receiver unit, a Link Control Unit (LCU), and a topside 7-P
 Sonar Processor Unit (TPU). The projector and receiver are set up in a Mills Cross
 configuration. The 7125-ROV produces a 128° across track swath that is resolved
 into 512 discrete beams by the receive array. Each beam has a resolution of 1.0°
 across track, and 0.5° along track. Sound velocity at the face of the transducer is
 provided by an integrated Reson SV-70 sound velocimeter. The 7-P Sonar Processor
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 Unit has the following software versions installed: 7K Center Version 3.7.11.11, 7K
 UI Version 3.12.7.3, and 7K IO Version 3.4.1.11. Bathymetric data from the 7125-
ROV is used to provide object detection and complete coverage in shallow water. 

Serial Numbers

Vessel Installed On "Thomas Jefferson"

Processor s/n 50357

Transceiver s/n 50872 (LCU Bottle)

Transducer s/n n/a

Receiver s/n 808042

Projector 1 s/n 19082203

Projector 2 s/n n/a

Specifications

Frequency 400 kilohertz

Along Track 1 degrees
Beamwidth

Across Track 0.5 degrees

Max Ping Rate 50 hertz

Beam Spacing
Mode

Equidistant 

Beam Spacing
Number of
Beams

512

Max Swath Width 128 degrees

Depth Resolution 5 millimeters

Manufacturer
Specified

200 meters 
Depth Rating

Ship Usage 100 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.

System Accuracy
Tests

Vessel Installed On "Thomas Jefferson" "Thomas Jefferson"

Methods Reference Surface Lead line comparison

Results

Over the course of DN118 and
DN119, all MBES systems on
"Thomas Jefferson" and both
launches were run over the same
reference surface near Cape Charles
in Chesapeake Bay. All systems
were tidally reduced using a
provided TCARI grid and compared
against the 7125-ROV1 installed
on "Thomas Jefferson." The mean
difference was 0.050m with a
standard deviation of 0.052m.

On June 4, 2015, a lead line
comparison was conducted between
the ship multibeam sonars and a
lead line lowered over the side while
dead in the water. The Reson 7125
ROV system differed from the lead
line by -0.09m.

Snippets Sonar has snippets logging capability.
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Figure : Housing for ship mounted RESON 7125-ROV

A.2.2.2 Reson SeaBat 7125-SV1

Manufacturer Reson

Model SeaBat 7125-SV1

Description

The Reson SeaBat 7125-SV1 is a dual frequency (200/400kHz), high-resolution
 multibeam echo sounder system for shallow water depths. The recommended
 maximum range at 200kHz is 500m resulting in a 220 m depth limit for full swath
 coverage on a flat bottom. The 400kHz setting maximum range is 200m resulting
 in a 87m depth limit for full swath coverage on a flat bottom. The transducer
 assembly consists of single flat-faced receiver array and two projectors, one for each
 frequency.

The system is installed on TJ3102 using a Reson sled mount which is attached
 to a retractable arm. The integrated system includes a 200 kHz Projector unit, a
 400 kHz Projector unit, a Receiver unit, and a topside 7-P Sonar Processor Unit
 (TPU). The projectors and receiver are set up in a Mills Cross configuration. The
 7125-SV1 produces a 128° across track swath.  The 400 kHz frequency has a
 0.54° across-track resolution and 1° along-track resolution, and is resolved into
 512 discrete beams. The 200 kHz frequency has a 1.1° across-track resolution
 and 2.2° along-track resolution, and is resolved into 256 discrete beams. Sound
 velocity at the face of the transducer is provided by an integrated Reson SV-71
 sound velocimeter. The Reson 7125-SV1 can be configured for roll stabilization. In
 roll-stabilized mode, the sonar can operate in environments with up to +/- 10 degrees



2015 DAPR Version 1           NOAA Ship Thomas Jefferson                

19

 of roll without degrading system performance. The 7-P Sonar Processor Unit has
 the following software versions installed: 7K Center: IO Version 3.12.7.3, 7K UI
 Version 3.1.2.7.3. Bathymetric data from the 7125-SV1 is used to provide object
 detection and complete coverage in shallow water. 

Serial Numbers

Vessel Installed On TJ3102

Processor s/n 1312032

Transceiver s/n n/a

Transducer s/n n/a

Receiver s/n 0309006

Projector 1 s/n 2909185

Projector 2 s/n 2208005

Specifications

Frequency 200 kilohertz 400 kilohertz

Along Track 2.2 degrees Along Track 1.0 degrees
Beamwidth

Across Track 1.1 degrees Across Track 0.54 degrees

Max Ping Rate 50 hertz 50 hertz

Beam Spacing
Mode

Equidistant 
Beam Spacing
Mode

Equidistant 

Beam Spacing
Number of
Beams

256
Number of
Beams

512

Max Swath Width 128 degrees 128 degrees

Depth Resolution 6 millimeters 6 millimeters

Manufacturer
Specified

220 kilometers 
Manufacturer
Specified

87 meters 
Depth Rating

Ship Usage 200 meters Ship Usage 50 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.

System Accuracy
Tests

Vessel Installed On TJ3102

Methods Reference Surface

Results

Over the course of DN118 and DN119, all MBES systems on "Thomas
Jefferson" and both launches were run over the same reference surface
near Cape Charles in Chesapeake Bay. All systems were tidally reduced
using a provided TCARI grid and compared against the 7125-ROV1
installed on "Thomas Jefferson." The mean difference was 0.050m with a
standard deviation of 0.052m.

Snippets Sonar has snippets logging capability.

A.2.2.3 Reson SeaBat 7125-SV2
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Manufacturer Reson

Model SeaBat 7125-SV2

Description

The Reson SeaBat 7125-SV2 is a dual frequency (200/400kHz), high-resolution
 multibeam echo sounder system for shallow-water depths. The recommended
 maximum range at 200kHz is 500m resulting in a 220 m depth limit for full swath
 coverage on a flat bottom. The 400kHz setting maximum range is 200m resulting in
 a 87m depth limit for full swath coverage on a flat bottom. The transducer assembly
 consists of single flat-faced receiver array and one curved projector, which can
 transmit at either 200kHz or 400kHz.

It is hull mounted on “Thomas Jefferson,” on the portside transducer pod. The
 system is also installed on TJ3102 using a Reson sled mount which is attached to a
 retractable arm. The integrated system includes a dual 200kHz & 400 kHz Projector
 unit, a Receiver unit, and a topside 7-P Sonar Processor Unit (TPU). The projector
 and receiver are set up in a Mills
Cross configuration. The 7125-SV2 produces a across track swath of 140° in
 equidistant mode and 165° in equi-angle mode. At 200kHz the across track swath is
 resolved into 256 discrete beams by the receive array. Each beam is has a resolution
 of 2° across track and 1° along track. At 400kHz the across track swath is resolved
 into 512 discrete beams by the receive array. Each beam has a resolution of 1° across
 track and 0.5° along track. Sound velocity at the face of the transducer is provided
 by an integrated Reson SV-70 sound velocimeter. The 7-P Sonar Processor Unit has
 the following software versions installed: 7K Center: 7K Center Version # 6.0.0.11,
 7K UI Version 4.1.0.7, 7K IO Version 4.1.0.1. Bathymetric data from the 7125 SV2
 is used to provide object detection and complete coverage in shallow water. 

Serial Numbers

Vessel Installed On S222 TJ3101

Processor s/n 18340713036 18341313046

Transceiver s/n n/a n/a

Transducer s/n n/a n/a

Receiver s/n unknown 1513550

Projector 1 s/n unknown 1513528

Projector 2 s/n n/a n/a
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Specifications

Frequency 200 kilohertz 400 kilohertz

Along Track 2 degrees Along Track 1 degrees
Beamwidth

Across Track 1 degrees Across Track 0.5 degrees

Max Ping Rate 50 hertz 50 hertz

Beam Spacing
Mode

Equidistant 
Beam Spacing
Mode

Equidistant 

Beam Spacing
Number of
Beams

256
Number of
Beams

512

Max Swath Width 140 degrees 140 degrees

Depth Resolution 6 millimeters 6 millimeters

Manufacturer
Specified

220 meters 
Manufacturer
Specified

87 meters 
Depth Rating

Ship Usage 200 meters Ship Usage 50 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.

System Accuracy
Tests

Vessel Installed On "Thomas Jefferson" and TJ3101 "Thomas Jefferson"

Methods Reference Surface Lead line comparison

Results

Over the course of DN118 and
DN119, all MBES systems on
"Thomas Jefferson" and both
launches were run over the same
reference surface near Cape Charles
in Chesapeake Bay. All systems
were tidally reduced using a
provided TCARI grid and compared
against the 7125-ROV1 installed
on "Thomas Jefferson." The mean
difference was 0.050m with a
standard deviation of 0.052m.

On June 4, 2015, a lead line
comparison was conducted between
the ship multibeam sonars and a
lead line lowered over the side while
dead in the water. The Reson 7125
SV2 system differed from the lead
line by -0.13m.

Snippets Sonar has snippets logging capability.

A.2.3 Single Beam Echosounders

A.2.3.1 ODOM Echotrac CV-200

Manufacturer ODOM

Model Echotrac CV-200
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Description
The Odom Echotrac CV-200 is a dual frequency, digital recording echo sounder.
 Identical systems are hull mounted on TJ3101 and TJ3102. 

Serial Numbers

Vessel TJ3101 TJ3102

Processor s/n 3260 2917

Transducer s/n TR2160 TR7698

Specifications

Frequency 24 kilohertz 200 kilohertz

Along Track 20 degrees Along Track 4 degrees
Beamwidth

Across Track 20 degrees Across Track 4 degrees

Max Ping Rate 20 hertz 20 hertz

Depth Resolution 0.01 meters 0.01 meters

Manufacturer

Specified
1500 meters

Manufacturer

Specified
200 meters

Depth Rating

Ship Usage 1000 meters Ship Usage 150 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.

System Accuracy
Tests

Vessel Installed On TJ3101 and TJ3102

Methods None

Results
The ODOM Echotrac systems aboard TJ3101 and TJ3102 are considered
backup echo sounders, to be used if the multibeam systems fail. System
accuracy tests will be preformed if the systems are activated.

A.2.3.2 ODOM Echotrac CV100

Manufacturer ODOM

Model Echotrac CV100

Description The Odom Echotrac CV100 is a dual frequency, digital recording echosounder.   

Serial Numbers

Vessel Z-Boat 1

Processor s/n 005997

Transducer s/n N/A
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Specifications

Frequency 24 kilohertz 200 kilohertz

Along Track 20 degrees Along Track 4 degrees
Beamwidth

Across Track 20 degrees Across Track 4 degrees

Max Ping Rate 20 hertz 20 hertz

Depth Resolution 0.01 meters 0.01 meters

Manufacturer

Specified
100 meters

Manufacturer

Specified
100 meters

Depth Rating

Ship Usage 10 meters Ship Usage 10 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.

System Accuracy
Tests

Vessel Installed On Z-Boat 1

Methods Reference Surface

Results
A comparison between data acquired between Launch 3102's Reson
7125 and the Odom CV100 on Z-1 yielded a mean difference of 0.079m.
Comparison between Z-1 and Z-2 yielded a difference of 0.007m.

A.2.3.3 Odom Echotrac CV100

Manufacturer Odom

Model Echotrac CV100

Description The Odom Echotrac CV100 is a dual frequency, digital recording echosounder.   

Serial Numbers

Vessel Z-2

Processor s/n N/A

Transducer s/n N/A

Specifications

Frequency 24 kilohertz 200 kilohertz

Along Track 20 degrees Along Track 4 degrees
Beamwidth

Across Track 20 degrees Across Track 4 degrees

Max Ping Rate 20 hertz 20 hertz

Depth Resolution 0.01 meters 0.01 meters

Manufacturer

Specified
100 meters

Manufacturer

Specified
100 meters

Depth Rating

Ship Usage 10 meters Ship Usage 10 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.
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System Accuracy
Tests

Vessel Installed On Z-2

Methods Reference Surface

Results
A comparison between data acquired between Launch 3102's Reson
7125 and the Odom CV100 on Z-2 yielded a mean difference of 0.115m.
Comparison between Z-2 and Z-1 yielded a difference of 0.007m.

A.2.4 Phase Measuring Bathymetric Sonars

No phase measuring bathymetric sonars were utilized for data acquisition.

A.2.5 Other Echosounders

No additional echosounders were utilized for data acquisition.

Additional Discussion

The Klein 5000 V2 is a Phase Measuring Bathymetric Sonar, but it is not used in that capacity so it is
 documented above as a SSS, which is how it is used aboard "Thomas Jefferson."

A.3 Manual Sounding Equipment

A.3.1 Diver Depth Gauges

No diver depth gauges were utilized for data acquisition.

A.3.2 Lead Lines

Manufacturer Ship's Force

Model n/a

Description
The lead lines aboard “Thomas Jefferson” are standard lead lines, constructed and
 calibrated in accordance with Appendix 1 of NOAA's Field Procedures Manual
 (2013 ed). 
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Serial Numbers

TJ A 16m

TJ S222 23m

TJ 07 2012

Calibrations

Serial Number TJ A 16m TJ S222 23m TJ 07 2012

Date 2015-04-15 2015-04-15 2015-04-15

Procedures

The lead line was

calibrated against a

steel measuring tape.

The lead line was

calibrated against a

steel measuring tape.

The lead line was

calibrated against a

steel measuring tape.

Accuracy Checks No accuracy checks were performed.

Correctors None of the lead lines required correctors.

Non-Standard
Procedures

Non-standard procedures were not utilized.

Figure : Lead line used aboard Thomas Jefferson and her survey launches
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A.3.3 Sounding Poles

Manufacturer Ship's Force

Model n/a

Description
“Thomas Jefferson” has two non-traditional sounding poles. Both poles are round
 steel with a plastic covering, capped by a weighted metal shoe. Each pole is 4 meters
 in length, with graduations at 0.25m. 

Serial Numbers
TJ-SP-1

TJ-SP-2

Calibrations

Serial Number TJ-SP-1 TJ-SP-2

Date 2015-04-29 2015-04-29

Procedures
The sounding pole was calibrated

using a steel tape.

The sounding pole was calibrated

using a steel tape.

Accuracy Checks No accuracy checks were performed.

Correctors No correctors were required.

Non-Standard
Procedures

Non-standard procedures were not utilized.
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Figure : Sounding pole used aboard Thomas Jefferson and her survey launches.
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A.3.4 Other Manual Sounding Equipment

No additional manual sounding equipment was utilized for data acquisition.

A.4 Positioning and Attitude Equipment

A.4.1 Applanix POS/MV

Manufacturer Applanix (a Trimble company)

Model 320 v.4 & 320 v.5

Description

“Thomas Jefferson” and both of her launches are equipped with Applanix POS/MV
 320 Position and Orientation Sensors (version 5 on “Thomas Jefferson,” version 4
 on TJ3101 and TJ3102) to measure and calculate position and attitude. The POS/
MV is a GPS-aided inertial navigation system, which provides a blended position
 solution derived from both an Inertial Motion Unit (IMU) and an integrated GPS
 receiver. The IMU and GPS receiver are complementary sensors, and data from one
 are used to filter and constrain errors from the other. 

Position accuracy is displayed in real time by the POS/MV software and was
 monitored to ensure that positioning accuracy requirements as outlined in the NOS
 Hydrographic Surveys Specifications and Deliverables (HSSD) were not exceeded.
 In addition, the POS/MV software displays HDOP and the number of satellites used
 in position computation. Data acquisition was generally halted when an HDOP of
 2.5 was exceeded or the number of satellites available dropped below four.

However, because positional accuracy can be maintained by the POS/MV through
 short GPS outages with the help of the IMU, data acquisition was not halted during
 short periods of time when the HDOP and number of satellites used exceeded stated
 parameters. It has yet to be identified if this practice needs to be modified when
 using the MarineStar service or what the new operational constraints may be.

In addition to position, the Applanix POS/MV also provides accurate navigation and
 attitude data to correct for the effects of heave, pitch, roll and heading. The POS/
 MV generates attitude data in three axes (roll, pitch and heading) to an accuracy of
 0.02° or better. Heave measurements supplied by the POS/MV maintain an accuracy
 of 5% of the measured vertical displacement for movements that have a period
 of up to 20 seconds. The Heave Bandwidth filter was configured with a damping
 coefficient of 0.707. The cutoff period of the high pass filter was determined by
 estimating the swell period encountered on the survey grounds. These values
 ranged from 8 seconds (flat water) to 20 seconds (long period ocean swell), with
 values of 8 or 12 seconds typically. Currently the ship system is set to 9 seconds
 and the launches are set to 8 seconds. Intermittent problems with the heading
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 accuracy climbing above the ideal cutoff of 0.05° are observed. Heading accuracy
 is monitored by the launch crew and survey operations are temporarily suspended
 in the event that the error exceeds 0.08°. Applanix “TrueHeave” values are also
 recorded. The TrueHeave algorithm uses a delayed filtering technique to eliminate
 many of the artifacts present in real time heave data. The TrueHeave data were
 applied to Reson bathymetry in Caris HIPS post processing. Full POSPac data are
 also recorded on “Thomas Jefferson” and both of her survey launches. This data is
 used to post process POS/MV data to produce superior position and attitude data in
 the form of a Smoothed Best Estimate of Trajectory (SBET) which is then applied in
 Caris. 

PCS

Manufacturer Applanix

Model 320 v.4

Description

The PCS blends raw acceleration measurements from the IMU, with

position information from the GPS antennas and RTCM beacon, creating

a tightly-coupled position and orientation solution. The PCS outputs a one

Pulse Per Second (PPS) signal to integrated systems to accurately time-

stamp data.

Firmware Version 5.08

Software Version 5.8.0.0

Serial Numbers

Vessel Installed

On
TJ3101 TJ3102

PCS s/n 3245 3954

Manufacturer Applanix

Model 320 v.5

Description

The PCS blends raw acceleration measurements from the IMU, with

position information from the GPS antennas and RTCM beacon, creating

a tightly-coupled position and orientation solution. The PCS outputs a one

Pulse Per Second (PPS) signal to integrated systems to accurately time-

stamp data.

Firmware Version 8.23

Software Version 7.92

Serial Numbers

Vessel Installed

On
S222

PCS s/n 6497
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IMU

Manufacturer Applanix

Model LN 200

Description

The POS M/V Inertial Measurement Unit (IMU) is used to record the

amount of heave, pitch, and roll experienced by the vessel. The IMU is

located at the vessel's central reference point, and is strapped down to

the vessel. Since the IMU is fixed to the vessel, the motion experienced

by the IMU is, by definition, the same motion experienced by the vessel.

The IMU housing contains three orthogonally placed accelerometers,

which sense acceleration in the x, y, and z directions. It also contains three

orthogonally placed gyros, which sense angular rate of motion around the

three axes. The measured amount of acceleration and rate of rotation is

then used to find the degree of pitch, roll, and heave experienced by the

vessel. Data from the IMU is also combined with data from the GNSS

antennas to calculate vessel heading.

Serial Numbers

Vessel Installed

On
S222 TJ3101 TJ3102

IMU s/n 1074 352 356

Certification

IMU s/n 1074 352 356

Certification

Date
2014-09-25 2014-01-03 2014-01-21

Antennas

Manufacturer Trimble

Model Zephyr 2

Description A high gain GNSS antenna

Serial Numbers

Vessel Installed

On
Antenna s/n

Port or

Starboard

Primary or

Secondary

S222 6948 Port Primary

S222 6950 Starboard Secondary

Manufacturer Trimble

Model GA830

Description A high gain GNSS antenna.

Serial Numbers

Vessel Installed

On
Antenna s/n

Port or

Starboard

Primary or

Secondary

S222 7238 Port Primary

S222 7239 Starboard Secondary

GAMS Calibration
Vessel S222 TJ3101 TJ3102

Calibration Date 2015-06-16 2015-05-19 2015-05-19
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Configuration
Reports

Vessel S222 TJ3101 TJ3102

Report Date 2015-04-17 2015-05-19 2015-05-19

A.4.2 DGPS

Description

The Trimble SPS361 receiver uses RTCM DGPS corrections either broadcast free
 by IALA Beacon stations, from SBAS (Satellite Based Augmentation Systems) or
 via an external radio or Internet connection from a DGPS reference station.  GPS
 correctors are fed to the Applanix POS/MVs to produce real time differentially
 corrected positions. 

Antennas

Manufacturer Trimble

Model GA530

Description

RTCM DGPS antenna that is designed to be placed on a rover unit. The

antenna receives L1, L2, Beacon, OmniSTAR (now called MarineStar),

and SBAS signals.

Serial Numbers

Vessel Installed

On
S222 TJ3101 TJ3102

Antenna s/n 13019 13008 12987
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Receivers

Manufacturer Trimble

Model SPS361

Description

The Trimble SPS361 receiver uses RTCM DGPS corrections either

broadcast free by IALA Beacon stations, from SBAS (Satellite Based

Augmentation Systems) or via an external radio or Internet connection

from a DGPS reference station.

Firmware Version 4.70

Serial Numbers

Vessel Installed

On
S222 TJ3101 TJ3102

Antenna s/n 5229D53057 5229D53050 5229D53059

Manufacturer Trimble

Model SPS351

Description

The Trimble SPS351 receiver uses RTCM DGPS corrections either

broadcast free by IALA Beacon stations, from SBAS (Satellite Based

Augmentation Systems) or via an external radio or Internet connection

from a DGPS reference station.

Firmware Version 4.70

Serial Numbers
Vessel Installed On Z-1 Z-2

Antenna s/n 5449R80011 5402R05037

Description

Fugro MarineStar is a commercial service that provides real-time GPS correctors
 via satellite.  The correctors are derived using a Precise Point Positioning (PPP)
 approach and are based on a state estimation of the GPS system rather than a
 differential correction.  The state estimation includes real-time estimate of satellite
 orbits, clock errors, and atmospheric delays.  The specified accuracy advertised by
 MarineStar are generally less than 10cm in the horizontal and 15cm in the vertical at
 95% confidence interval. 

The MarineStar corrector signal is received on the L1 channel of the primary POS
 antenna and is logged directly into the POS PCS.  As such, no additional antenna or
 receiver equipment is necessary. 

Antennas No DGPS antennas were installed.

Receivers No DGPS receivers were installed.

A.4.3 Trimble Backpacks
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Trimble backpack equipment was not utilized for data acquisition.

A.4.4 Laser Rangefinders

Manufacturer Laser Technology Inc.

Model TruPulse 360 R

Description

LTI TruPluse 360 R is a hand held laser range finder. 

The device can be operated in 5 modes: horizontal distance, vertical distance, slope
 distance and inclination (or percent slope), 3-point flexible height routine with auto
 sequencing, and 2-shot missing line routine. 

There are also 5 target modes which are standard, closest, farthest, continuous, and
 filter. 

The Measurement range is 0 to 3280ft typical and 6560ft max to reflective target,
 inclination range of +/- 90 degrees and an azimuth range 0 to 359.9 degrees. The
 range finder is accurate in distance +/- 0.30 meters to high quality targets and +/-1
 meter to low quality targets, inclination accuracy of +/-0.25 degrees and azimuth
 accuracy of +/- 1 degree. 

Serial Numbers 000172

DQA Tests DQA test was not performed.
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Figure : TruPulse 360 R

A.4.5 Other Positioning and Attitude Equipment

No additional positioning and attitude equipment was utilized for data acquisition.

A.5 Sound Speed Equipment
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A.5.1 Sound Speed Profiles

A.5.1.1 CTD Profilers

A.5.1.1.1 Sea-Bird Electronics SBE19

Manufacturer Sea-Bird Electronics

Model SBE19

Description

“Thomas Jefferson” uses a Sea-Bird Electronics SeaCat SBE19 Conductivity,
 Temperature, and Depth (CTD) Profiler to collect vertical sound speed profiles. The
 speed of sound is calculated from temperature, salinity, and pressure measurements.
 Temperature is measured directly. Salinity is calculated from measured electrical
 conductivity. Depth is calculated from strain gauge pressure. The system is
 configured for a sampling rate of 0.5 seconds. Depending on the depth of water, the
 profiler is either deployed by hand, or using a winch. 

Serial Numbers
Vessel Installed On S222

CTD s/n 192472-0285

Calibrations

CTD s/n 192472-0285

Date 2015-04-17

Procedures Calibrations performed by Sea-Bird Electronics
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Figure : Sea-Bird 19 CTD used aboard Thomas Jefferson S222
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A.5.1.1.2 Sea-Bird Electronics SBE19+

Manufacturer Sea-Bird Electronics

Model SBE19+

Description

“Thomas Jefferson,” TJ3101, and TJ3102 all use Sea-Bird Electronics SeaCat
 SBE19+ Conductivity, Temperature, and Depth (CTD) Profilers to collect vertical
 sound speed profiles. The speed of sound is calculated from temperature, salinity,
 and pressure measurements. Temperature is measured directly. Salinity is calculated
 from measured electrical conductivity. Depth is calculated via strain gauge pressure.
 The system is configured for a sampling rate of 0.5 seconds. Aboard the launches,
 the profiler is deployed by hand. Aboard “Thomas Jefferson,” the profiler is either
 hand deployed, or deployed via a winch, depending on the depth of water. 

Serial Numbers
Vessel Installed On S222 TJ3101 TJ3102

CTD s/n 19P60744-6667 19P33589-4486 19P33589-4487

Calibrations

CTD s/n 19P60744-6667 19P33589-4486 19P33589-4487

Date 2015-05-19 2015-05-19 2015-05-19

Procedures
Calibrations performed

by Sea-Bird Electronics

Calibrations performed

by Sea-Bird Electronics

Calibrations performed

by Sea-Bird Electronics
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Figure : Sea-Bird 19+ CTD used aboard Thomas Jefferson S-222 and her survey launches.
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A.5.1.2 Sound Speed Profilers

A.5.1.2.1 AML Oceanographic AML Smart/Micro SV&P Probe

Manufacturer AML Oceanographic

Model AML Smart/Micro SV&P Probe

Description

“Thomas Jefferson” uses an AML Micro SV&P Probe to collect speed of sound
 profiles via the Brooks Ocean Technology MVP. The speed of sound is measured
 directly using a 'time-of-flight' sensor. Depth is calculated via strain gauge pressure.
 The currently installed probe is the Micro SV&P, serial number 7591. 

Any changes to the installed probe will be noted in the Descriptive Report of the
 effected survey.

Calibration files are included in Appendix IV of this report. 

Serial Numbers
Vessel Installed On S222 S222 S222

Sound Speed Profiler s/n Smart SV&P 4988 Smart SV&P 5340 Smart SV&P 7591

Calibrations

Sound Speed Profiler s/n 4988 5340 7591

Date 2015-04-17 2015-05-19 2015-05-19

Procedures

Calibrations

performed by AML

Oceanographic.

Calibrations

performed by AML

Oceanographic.

Calibrations

performed by AML

Oceanographic.
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Figure : AML Smart SV&P Probe used in the MVP free-fall fish.

A.5.2 Surface Sound Speed

A.5.2.1 AML Oceanographic AML Smart SV&T Probe

Manufacturer AML Oceanographic

Model AML Smart SV&T Probe

Description
“Thomas Jefferson” uses either an AML Smart SV&T Probe, or a Reson SV-70
 Probe to measure sound velocity at the face of the Reson-ROV and -SV2
 transducers. The sensor is mounted in an insulated sea chest, and a pump is used
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 to collect water from near the transducer. The speed of sound is measured directly
 using a 'time-of-flight' sensor. The AML probe can also acquire temperature with a
 thermistor, however this measurement is not used by the Reson transducers. Sound
 speed values are output in real time to the Reson systems. 

The currently installed probe is the Reson SV-70, serial number 5011603. Any
 changes to the installed probe will be noted in the Descriptive Report of the affected
 survey.

Calibration files are included in Appendix IV of this report. 

Serial Numbers
Vessel Installed On S222 S222

Sound Speed Sensor s/n Smart SV&T 4823 Smart SV&T 5649

Calibrations

Sound Speed Sensor s/n 4823 5649

Date 2015-04-17 2015-05-19

Procedures
Calibration was performed by AML

Oceanographic.

Calibration was performed by AML

Oceanographic.

A.5.2.2 Reson SV-70

Manufacturer Reson

Model SV-70

Description

“Thomas Jefferson” uses either an AML Smart SV&T Probe, or a Reson SV-70
 Probe to measure sound velocity at the face of the Reson-ROV and -SV2
 transducers. The sensor is mounted in an insulated sea chest, and a pump is used
 to collect water from near the transducer. The speed of sound is measured directly
 using a 'time-of-flight' sensor. Sound speed values are output in real time to the
 Reson systems. 

The currently installed probe is the Reson SV-70, serial number 5011603. Any
 changes to the installed probe will be noted in the Descriptive Report of the effected
 survey.

Calibration files are included in Appendix IV of this report. 

Serial Numbers
Vessel Installed On S222

Sound Speed Sensor s/n 5011603

Calibrations

Sound Speed Sensor s/n 5011603

Date 2015-05-19

Procedures Calibration was performed by Teledyne RESON, Inc
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A.5.2.3 Reson SV-71

Manufacturer Reson

Model SV-71

Description

TJ3101 and TJ3102 us a Reson SV-71 to collect the speed of sound at the face of
 the Reson 7125-SV1 and -SV2 transducers. The sensor is bolted to the mounting
 sled, near the face of the transducer. The speed of sound is measured directly using a
 'time-of-flight' sensor, and integrated directly into the Reson processing unit. 

Serial Numbers
Vessel Installed On TJ3101 TJ3102

Sound Speed Sensor s/n 4211067 0810064

Calibrations

Sound Speed Sensor s/n 4211067 0810064

Date 2015-05-19 2015-05-19

Procedures
Calibration was performed by

Teledyne RESON, Inc

Calibration was performed by

Teledyne RESON, Inc

Figure : Reson SV-71 Sound Velocity Probe used for surface sound speed aboard TJ3101 & TJ3102

Additional Discussion

“Thomas Jefferson” primarily uses a Brooke Ocean Moving Vessel Profiler (MVP) installed on the port
 quarter to collect sound speed profiles. The integrated system consists of a computer controlled high-speed
 winch with cable metering, a conductor cable, and a free-fall fish (FFF). Housed in the FFF is an Applied
 Microsystems SV&P Smart Sensor (see above). The profiler is deployed at survey speed via the winch. 
 A traditional winch on the port side can collect stationary casts with the SeaBird SBE19 or SBE19+ as a
 backup to the MVP system.
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Figure : MVP winch aboard NOAA Ship Thomas Jefferson

A.6 Horizontal and Vertical Control Equipment

A.6.1 Horizontal Control Equipment

A.6.1.1 Base Station Equipment

No base station equipment was utilized for data acquisition.

A.6.1.2 Rover Equipment

No rover equipment was utilized for data acquisition.

Additional Discussion

The Horizontal Datum for all projects is the North American Datum of 1983 (NAD83). During data
 acquisition and initial processing, horizontal control for all survey data is derived from either differentially
 corrected GPS using USCG differential beacons or from the MarineStar realtime satellite corrector service.
 If DGPS is used, differential beacons are chosen based on their proximity to the survey grounds and the
 signal-to-noise ratio of the beacons if more than one beacon is near the survey grounds.

During post processing, horizontal control for MBES data is replaced with a Smooth Best Estimate
 Trajectory (SBET) positioning. In the case of DGPS, the SBET process overwrites the position solution with
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 an improved IAPPK solution.  In the case of MarineStar, SBETs are used to transform the reference frame
 from ITRF00 to NAD83.  A more detailed discussion of the processing pipeline is included in Section C.4.

A.6.2 Vertical Control Equipment

A.6.2.1 Water Level Gauges

No water level gauges were utilized for data acquisition.

A.6.2.2 Leveling Equipment

No water level gauges were utilized for data acquisition.

Additional Discussion

Vertical Datum for all projects is Mean Lower Low Water (MLLW), unless otherwise stated in the specific
 Descriptive Report. See Section C.5 for more details on the different methods used to reduce data to tidal
 datum.  "Thomas Jefferson" typically does not install additional tide gauges on projects.

The form of Vertical Control used for each survey will be listed in section C.1 of the Descriptive Report.

A.7 Computer Hardware and Software

A.7.1 Computer Hardware

Manufacturer Individual computers utilized are not discussed in this report.

Model See Additional Discussion for more information.

Description N/A 

Serial Numbers
Computer s/n Operating System Use

N/A N/A Acquisition and Processing

A.7.2 Computer Software
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Manufacturer Caris

Software Name HIPS/SIPS

Version 9.0.19

Service Pack

Hotfix

Installation Date 2015-09-03

Use Processing

Description

Caris HIPS (Hydrographic Information Processing System) is used for all initial
processing of multibeam and vertical beam echo sounder bathymetry data. The
program applies vessel offsets to the raw sonar data, corrects for tide and sound
velocity, and calculates a Total Propagated Uncertainty (TPU) for each sounding.
Individual soundings are then processed into a CUBE (Combined Uncertainty and
Bathymetry Estimator) surface. These surfaces are then reviewed in HIPS or BDB
(see below) for depth fliers, systematic errors, and agreement with adjoining and
prior surveys. Caris SIPS (Side Scan Information Processing System) is used for all
processing of side scan sonar imagery, including cable layback correction, slant range
correction, contact selection, towpoint entry, and mosaic generation.

Manufacturer Caris

Software Name HIPS/SIPS

Version 9.0.16

Service Pack

Hotfix

Installation Date 2015-07-08

Use Processing

Description

Caris HIPS (Hydrographic Information Processing System) is used for all initial
processing of multibeam and vertical beam echo sounder bathymetry data. The
program applies vessel offsets to the raw sonar data, corrects for tide and sound
velocity, and calculates a Total Propagated Uncertainty (TPU) for each sounding.
Individual soundings are then processed into a CUBE (Combined Uncertainty and
Bathymetry Estimator) surface. These surfaces are then reviewed in HIPS or BDB
(see below) for depth fliers, systematic errors, and agreement with adjoining and
prior surveys. Caris SIPS (Side Scan Information Processing System) is used for all
processing of side scan sonar imagery, including cable layback correction, slant range
correction, contact selection, towpoint entry, and mosaic generation.

Manufacturer Caris

Software Name HIPS/SIPS

Version 9.0.12

Service Pack
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Hotfix

Installation Date 2015-04-18

Use Processing

Description

Caris HIPS (Hydrographic Information Processing System) is used for all initial
processing of multibeam and vertical beam echo sounder bathymetry data. The
program applies vessel offsets to the raw sonar data, corrects for tide and sound
velocity, and calculates a Total Propagated Uncertainty (TPU) for each sounding.
Individual soundings are then processed into a CUBE (Combined Uncertainty and
Bathymetry Estimator) surface. These surfaces are then reviewed in HIPS or BDB
(see below) for depth fliers, systematic errors, and agreement with adjoining and
prior surveys. Caris SIPS (Side Scan Information Processing System) is used for all
processing of side scan sonar imagery, including cable layback correction, slant range
correction, contact selection, towpoint entry, and mosaic generation.

Manufacturer Caris

Software Name HIPS/SIPS

Version 9.0.11

Service Pack

Hotfix

Installation Date 2015-04-10

Use Processing

Description

Caris HIPS (Hydrographic Information Processing System) is used for all initial
processing of multibeam and vertical beam echo sounder bathymetry data. The
program applies vessel offsets to the raw sonar data, corrects for tide and sound
velocity, and calculates a Total Propagated Uncertainty (TPU) for each sounding.
Individual soundings are then processed into a CUBE (Combined Uncertainty and
Bathymetry Estimator) surface. These surfaces are then reviewed in HIPS or BDB
(see below) for depth fliers, systematic errors, and agreement with adjoining and
prior surveys. Caris SIPS (Side Scan Information Processing System) is used for all
processing of side scan sonar imagery, including cable layback correction, slant range
correction, contact selection, towpoint entry, and mosaic generation.

Manufacturer Caris

Software Name Base Editor

Version 4.1

Service Pack

Hotfix

Installation Date 2015-03-07

Use Processing
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Description

Caris Base Editor (BDB) is used for quality control of multibeam and vertical beam
surfaces, and for management of survey features. CUBE and Uncertainty grids are
imported, and then reviewed for depth fliers and systematic errors, and agreement
with adjoining surveys. Multibeam contacts (designated soundings), side scan sonar
contacts, and detached position contacts are analyzed, grouped, and assigned S-57
classification.

Manufacturer Caris

Software Name Base Editor

Version 4.0

Service Pack

Hotfix

Installation Date 2015-03-19

Use Processing

Description

Caris Base Editor (BDB) is used for quality control of multibeam and vertical beam
surfaces, and for management of survey features. CUBE and Uncertainty grids are
imported, and then reviewed for depth fliers and systematic errors, and agreement
with adjoining surveys. Multibeam contacts (designated soundings), side scan sonar
contacts, and detached position contacts are analyzed, grouped, and assigned S-57
classification.

Manufacturer NOAA OCS HSTP

Software Name Pydro

Version 14.6

Service Pack r5164

Hotfix

Installation Date 2015-09-03

Use Processing

Description

HSTP Pydro is a suite of programs used to process survey data, and to generate
reports. FetchTides is used to create a .tid file from NWLON tide station data. Pydro
can be used to classify side scan sonar and multibeam bathymetry contacts and
manage survey features, however this functionality has largely been replaced by
Caris BASE Editor. Pydro is still used for the generation of chartlets, the generation
of Danger to Navigation reports, and to process TCARI tides. Velocipy is a program
used for processing sound velocity casts. This program converts the hexadecimal
SeaCat data to ASCII, and converts the ASCII data into a depth-binned sound
velocity file. MVP data is recorded in a .txt format, and can be binned via Velocipy
without conversion to ASCII. The resulting .svp files are applied to MBES and
VBES data during post processing to correct for sound velocity variation within the
water column. XmlDR is used to generate Descriptive Reports for each survey and
the Data Acquisition Processing Report for each project.
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Manufacturer HYPACK, Inc

Software Name Hypack 2015

Version

Service Pack

Hotfix

Installation Date 2015-03-19

Use Acquisition

Description

Hypack is used to acquire VBES data in a .raw format, and detached positions, in .tgt
format. It is also used for vessel navigation during MBES and SSS data acquisition.
Hysweep is a module for Hypack used to acquire Reson 7125 MBES data in .HSX
format. It receives input from the Reson 7125, the Reson SV-70 & SV-71 probes, and
the Applanix POS/MV systems.

Manufacturer Applanix

Software Name POSPac MMS

Version 7.1

Service Pack

Hotfix

Installation Date 2015-04-20

Use Processing

Description
Applanix POSPac MMS is used to create SBETs, which provide horizontal and
vertical control to bathymetric data.

Manufacturer Applanix

Software Name MV-POSView

Version 5.8

Service Pack

Hotfix

Installation Date 2015-04-10

Use Acquisition

Description

The MV-POSView controller program is used on the ship's launches to configure
and operate the POS/MV attitude and positioning system. This program is also used
to record the POS/MV .000 files used to produce the SBET files applied in Caris to
improve attitude and navigation.

Manufacturer Applanix

Software Name MV-POSView
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Version 7.92

Service Pack

Hotfix

Installation Date 2015-04-08

Use Acquisition

Description

The MV-POSView controller program is used on the ship to configure and operate
the POS/MV attitude and positioning system. This program is also used to record
the POS/MV .000 files used to produce the SBET files applied in Caris to improve
attitude and navigation.

Manufacturer Brooke Ocean

Software Name MVP

Version 2.450

Service Pack

Hotfix

Installation Date 2007-02-01

Use Acquisition and Processing

Description The MVP program is used to control the MVP winch and fish.

Manufacturer QPS, Inc

Software Name Fledermaus

Version 7.4.0d

Service Pack

Hotfix

Installation Date 2015-04-10

Use Processing

Description Fledermaus is used to process backscatter mosaics.

Manufacturer ESRI, Inc

Software Name ArcGIS

Version 10.3

Service Pack

Hotfix

Installation Date 2015-04-08

Use Acquisition and Processing
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Description

ArcGIS is used for initial survey planning, such as the creation of line plans for
export into Hypack to guide the survey acquisition. ArcGIS is also used for data
analysis, where a variety of tools and a high level of customization allow for detailed
analysis of surfaces and data products.

Additional Discussion

Computer hardware that was a core component of a sensor is listed under the Echo Sounding section,
 referred to as the "Processor" for MBES systems or the "TPU" for the SSS systems.  Computers used for
 processing of the data or controlling acquisition were completely interchangeable and the serial numbers
 used were not tracked. 

A.8 Bottom Sampling Equipment

A.8.1 Bottom Samplers

A.8.1.1 Ponar Wildco #1728

Manufacturer Ponar Wildco

Model #1728

Description
The Ponar Wildco is a winch-deployed bottom sampler used aboard “Thomas
 Jefferson.” 
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Figure : Ponar style grab sampler used aboard NOAA Ship Thomas Jefferson.

A.8.1.2 Kahlsico Mud Snapper 214WA100

Manufacturer Kahlsico Mud Snapper

Model 214WA100

Description
The Kahlsico Mud Snapper is a hand held bottom sampler that is used aboard TJ3101
 and TJ3102. 
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Figure : Snapper type grab sampler used aboard TJ3101 & TJ3102.

B Quality Control

B.1 Data Acquisition

B.1.1 Bathymetry

B.1.1.1 Multibeam Echosounder

All multibeam data is logged using Hypack/Hysweep in the .HSX format. During acquisition, the
 hydrographer;
- Monitors the Reson SeaBat interface for errors and data quality;
- Adjusts range scale, power, gain, pulse width, swath width, absorption, spreading, and gates to ensure
maximum data quality;



2015 DAPR Version 1           NOAA Ship Thomas Jefferson                

53

- Monitors the Hysweep interface;
- Monitors the vessel speed and adjusts as necessary to ensure density specifications are met.

TJ3101 and TJ3102 acquire complete coverage MBES data using polygons, with coverage being monitored
 via Hypack's matrix feature. 100% and 200% side scan sonar with concurrent MBES or VBES is acquired
 using preplanned lines, with a matrix in the background.  Holidays are acquired as they occur, with a
 final quality control check for density rarefactions occurring near the completion of acquisition. The ship
 acquires all MBES data using preplanned lines, with a matrix in the background, with holidays being noted
 as they occur. Near the end of main scheme acquisition, a quality control check for density rarefactions is
 completed, and all gaps in coverage are acquired.

B.1.1.2 Single Beam Echosounder

All VBES data is logged using ODOM eChart in the .bin and .raw formats. The .raw contains the depth data,
 the .bin files contain water column data. During acquisition the hydrographer:
- Monitors real-time data in the ODOM eChart window;
- Adjusts gain and power as needed to ensure data quality.

B.1.1.3 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not acquired.

B.1.2 Imagery

B.1.2.1 Side Scan Sonar

All side scan sonar data is logged using Klein SonarPro, in the .SDF format. During acquisition the
 hydrographer:
- Monitors range, towfish height, heading, pitch, roll, latitude, longitude, speed, pressure, and temperature;
- Adjusts towfish height, in accordance with Field Procedures Manual.

B.1.2.2 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar imagery was not acquired.

B.1.3 Sound Speed

B.1.3.1 Sound Speed Profiles

“Thomas Jefferson” uses an AML Micro SV&P Probe installed inside an MVP free-fall fish to
acquire sound speed profiles. Profiles aboard the ship are acquired at 30 - 90 minute intervals. The interval
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between casts is monitored real-time using NOAA's CastTime program. CastTime compares successive
casts using a ray-tracing uncertainty analysis that estimates the effect of the sound speed variability towards
multibeam echo sounding. When the profile comparisons show redundancy, meaning that the effect of the
sound speed variability towards echo sounding is negligible, then this provides justification to relax the
sampling intervals towards the 90 minute bound. Conversely, when the comparisons show variability with
a significant effect towards echo sounding, the MVP usage is increased accordingly. At any time, sampling
intervals are adjusted on-the-fly at the discretion of the surveyor, to ensure spatial variability accounted for,
or if there is suspicion of sudden changes in the water-column.

TJ3101 and TJ3102 both use a Sea-Bird SBE19+ CTD to collect sound speed profiles, generally at 2 - 4
hour intervals. Casts are also conducted when changing survey areas, or when a change of weather, tide, or
current warrant. The launch crew also monitors the real time display of the Reson SVP-70 sound velocity
probe for drastic changes in the surface sound velocity indicative of the need for a new cast. 

Velocipy software is used for both data processing and setting up Sea-Bird SEACAT instruments. Prior to
deployment the SEACAT voltage is checked. The SBE 19plus should have a minimum of 9.5 volts and the
SBE 19 should have a minimum of 7 volts. In the event of lower voltage readings, the instrument batteries
were changed.

The site selected should be in the deepest portion of the project area expected to be surveyed.

When conducting SEACAT casts with the SBE 19, the 3-2-1 rule of thumb is followed. The instrument
should be turned on and allowed to sit on deck for 3 minutes while the sensors settle and form baseline. The
instrument is then set to soak just below the surface for 2 minutes. Finally the instrument is lowered at a rate
of 1 meter/second.

When conducting SEACAT casts with the SBE 19plus, the instrument should be lowered and held just
below the water's surface for about 1 minute to allow air to escape the salinity cell. After soaking the
instrument, it should be lowered at a rate of 1 meter/second through the water column. In areas with lenses
of fresh water or other complex sound speed variation near the surface, the instrument should be lowered
slowly (in some cases, much less than 1 meter/second) through the first 5-10 meters of water in order to
accurately sample the sound speed. After this initial descent, the instrument should proceed to drop at a rate
of 1 meter/second.

The Moving Vessel Profiler (MVP) is an automated winch system that deploys a fish containing a sound
 speed sensor by free fall. The fish is towed behind the survey vessel in a ready position that is marked by
 messengers attached to the tow cable. Ideally, at survey speeds the fish is “flying” just above the depth of
 the sonar transducers. The specified depth deployed is selected by specifying a distance off the bottom.
 Once at the depth limit, the winch freefall is automatically stopped and the drag forces on the fish cause it
 to rise toward the surface due to the ship's forward motion. The cable slack is then pulled in by the winch to
 the towing position.

Aboard all platforms, the hydrographer processes each cast immediately, then reviews it for erroneous data.
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Figure : This image intentionally left blank

B.1.3.2 Surface Sound Speed

“Thomas Jefferson” uses an Reson SV-70 probe to find the speed of sound at the Reson transducer face.
 TJ3101 and TJ3102 use a Reson SV-71 to acquire sound speed at the transducer face. These sound speed
 values are applied in real-time to all MBES systems to provide refraction
corrections to flat-faced transducers.

The accuracy of each surface sound speed device is checked against the closest CTD data point after every
 CTD cast.

B.1.4 Horizontal and Vertical Control

B.1.4.1 Horizontal Control

Depending on Project Instructions and availability, "Thomas Jefferson" used one of the three  following
 methods for horizontal control:

USCG Differential GPS Beacons:
“Thomas Jefferson” and her survey launches all use differentially-corrected GPS via a USCG DGPS beacon
 to establish horizontal position for all data acquisition and initial processing. The frequency of the assigned
 beacon is programmed into the Trimble DGPS receiver. The minimum number of satellites, their minimum
 elevation above the horizon, and the age of pseudorange correctors are also set via the Trimble software
 interface. During acquisition, differential correctors are sent to the Applanix POS M/V via serial connection.
 Total positional accuracy is monitored inside the MV-POSView window.

During post-processing horizontal positioning can be shifted to an Inertially Aided Post-Processed Kinematic
 (IAPPK) solution. The solution is created by combining GPS/GNSS satellite ephemeris and clock data with
 position information downloaded from a network of Continually Operating Reference Stations (CORS).
 The resulting position data is corrected for the effects of atmospheric interference on the GPS signal. The
 corrected GPS position is then combined with the vessel's inertial data using the POSPac MMS program to
 create a Smoothed Best Estimate of Trajectory (SBET). The resulting position can be used to apply higher
 quality navigation information to the processed data.

MarineStar Realtime PPP Corrector Service:
“Thomas Jefferson” and her survey launches all use the Fugro MarineStar satellite based corrector service to
 provide realtime correction to the horizontal position and ellipsoid height for all data acquisition and initial
 processing.  The corrector signal is received on the L1 channel of the POS/MV primary GPS antenna and
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 logged directly into the POS/MV.  The POS files produced during acquisition are then processed through
 the POSPac MMS software to produce an SBET in the NAD83 reference frame and an RMS file containing
 the realtime uncertainty estimates of the position and attitude data.

B.1.4.2 Vertical Control

Vertical Control methods for each project are specified in the project instructions, and utilize one of three
 possible methods:

-Zoned Tides: when using zoned tides vertical control is based on one or more NWLON stations operated
 by CO-OPS. Co-range and co-phase measurements from the NWLON stations are used to break the project
 area into zones, each of which has a distinct time-of-tide and range-of-tide corrector. CO-OPS provides the
 field unit with a Caris compatible file which takes observed water levels from surrounding gauges, computes
 the time and range correctors for each zone, and uses the zoned data to reduce bathymetric soundings to
 MLLW. “Thomas Jefferson” does not install tertiary gauges in support of tidal modeling. After completion
 of a survey area, CO-OPS verifies all zoning and water level data.

-TCARI Tides: Tidal Constituent and Residual Interpretor is an alternative to discrete zoning. A TCARI grid
 is a triangulated network that uses two or more water level gauges to create a weighted network across the
 survey area. Each point on the grid has a discrete tidal interpolation that is based on the horizontal nearness
 of a water level gauge, the harmonic constants of the area, and the residual water levels. Bathymetric data
 is then reduced to MLLW using the TCARI tool in Pydro. Like zoned tides, CO-OPS verifies TCARI grids
 and observed water levels at the conclusion of each survey.

-GPS Tide: The IAPPK or 5P solution described in the Horizontal Control section can also be used to
 provide vertical control. Using this method the bathymetric data is initially referenced to the ellipsoid using
 the high accuracy position data. It is later reduced to MLLW using a separation model called VDatum,
 which is provided to the field unit by NOAA's Hydrographic Services Division.

B.1.5 Feature Verification

The following work flow is used to develop and verify features:
- The location of all potentially significant features are opened in Caris BASE Editor (BDB). Any indication
 of shoaling found in VBES data is also noted, and the area outlined in BDB;
- A development area polygon is exported from BDB and a line plan is created using ArcMap, creating line
 spacing that will ensonify all features with near nadir beams;
- Object Detection level MBES data is collected over all SSS contacts, VBES designated soundings, and all
 possible shoals. 

Quality of data is controlled through:
- Real time monitoring during acquisition to ensure that all features are covered by near nadir beams;
- Post processing inspection of the CUBE surface's Density, Standard Deviation, and Uncertainty layers;
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- All developments are examined for significance. Objects found to be significant are flagged with a
 designated sounding, and become part of the Final Feature File.

B.1.6 Bottom Sampling

Bottom samples are collected in accordance with the recommended bottom sample plan provided in each
 survey's Project Reference File (PRF). The potential sample sites are examined by the Command and
 potentially culled based on the actual depths found during survey operations. Additional sample sites may
 also be added.

Aboard TJ3101 and TJ3102 bottom samples are collected using the Kahlsico Mud Snapper, while “Thomas
Jefferson” uses the winch-deployed Ponar Wildco. Once obtained, samples are analyzed for sediment type
 and classified with S-57 attribution using Caris BASE Editor. In the event that no sample is obtained after
 three attempts, the nature of the surface is characterized as "unknown". Samples are discarded after field
 analysis is complete.

B.1.7 Backscatter

As per the Field Procedures Manual, “Thomas Jefferson’s” current policy is to ensure quality by processing
 one line of backscatter per platform, per day.

All backscatter data is logged using Hypack/Hysweep in the .7k format.

B.1.8 Other

No additional data were acquired.

B.2 Data Processing

B.2.1 Bathymetry

B.2.1.1 Multibeam Echosounder
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Four workflows exist depending on whether a survey uses zoned tides, TCARI tides, MarineStar service and
 the Post-Processed Precise Point Positioning (5P) method, or Inertially Aided Post Processed Kinematic
 (IAPPK) method. A more detailed description of 5P and IAPPK SBET creation is covered below in Section
 B.2.4.

-Zoned Tides:
1) Convert raw .HSX data to Caris HDCS format 
2) Load Delayed Heave
3) Apply tide correctors
4) Apply sound speed correctors
5) Merge
6) Compute Total Propagated Uncertainty (TPU)

-TCARI Tides:
The TCARI Tides work flow is the same as Zoned Tides except that Step 3 applies the TCARI correctors via
 Pydro, and Step 6 applies "realtime" tidal uncertainty values instead of project specific static values.

-5P
1) Create SBET and RMS files in POSPac MMS.
2) Convert raw .HSX data to Caris HDCS format 
3) Load Delayed Heave
4) Import ancillary data: SBET and RMS
5) Apply tide correctors. While unused, if available these are useful for a QC check in Subset Editor.
6) Compute GPS Tides using the provided VDatum SEP model.
7) Apply sound speed correctors
8) Merge; use GPS Tides.
9) Compute Total Propagated Uncertainty (TPU)

-IAPPK
IAPPK requires a delay of around 48 hours to produce the SBET and RMS files, due to reliance on updates
 of CORS station and ephemeris data.  The need for fast QC of the data ("night processing") to allow
 planning of the next day's survey operations necessitates that initial processing must happen before the
 IAPPK solution is available.  As a result, it initially follows the tidal scheme appropriate to that project area
 (Zoned Tides or TCARI).  Once sufficient time has passed, SBETs and RMS files are produced and the data
 is reprocessed using the same work flow as 5P, skipping the conversion and Delayed Heave steps.

At this stage, all of the work flows merge into a common process.

1) Create CUBE surfaces. Surface resolution is dictated by the type of coverage required (Complete
 Coverage
vs. Object Detection), and the depth of water. Disambiguation method is NOAA CUBE Parameters.
Compliance with HSSD gridding requirements is strictly observed;
2) Review the CUBE surface for holidays.
3) Create a holiday line plan.
4) Review the uncertainty and standard deviation layers and address areas where the standards set by the
 HSSD are exceeded.
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5) Examine all surfaces for erroneous surface designation and evidence of systematic errors. Also identify
 features and look for evidence of shoaling.
6) Significant features are flagged 'designated', forcing the CUBE algorithm to honor the depth of the
 sounding.  Designated soundings are reviewed to ensure compliance with guidance in the HSSD.
7) Create finalized grids. In finalization, the standard deviation for each node in the surface is multiplied by
 1.96 to provide the 95% (2-sigma) confidence level. Standard deviation is then compared to the computed
 Total Vertical Uncertainty (TVU) for each node. The larger of the two values is retained as the finalized
 Uncertainty for each node.  Finalization is also when the surface is forced to honor designated soundings.

Figure : This image intentionally left blank

B.2.1.2 Single Beam Echosounder

All VBES data is converted using Caris. The workflow is as follows:
- Convert raw .bin and .raw data using Caris HIPS;
- Scan Navigation and Attitude data, flagging erroneous data as rejected;
- Apply TrueHeave, tide, and speed of sound correctors;
- Compute Total Propagated Uncertainty. Uncertainty values applied to the data follow recommendations of
NOAA's FPM (ed 2014) Appendix 4. The exception is MRU alignment uncertainties, which are set to zero.

Tidal zoning and sound speed error modeling is computed on a per-project basis, and is detailed in section
B.2.2 of the Descriptive Report;
- Scan all data using the Caris Single Beam Editor tool, flagging data from the water column and the sub-
bottom returns as rejected;
- When definition of the true bottom is ambiguous, the full water column Data can be inspected by viewing
 the Hypack created .bin files;
- Create Caris BASE Uncertainty weighted grids at 4-meter resolution;
- Analyze grids for features and for areas of shoaling, flagging them for development by a multibeam echo
 sounder.

Figure : This image intentionally left blank

B.2.1.3 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not processed.



2015 DAPR Version 1           NOAA Ship Thomas Jefferson                

60

B.2.1.4 Specific Data Processing Methods

B.2.1.4.1 Methods Used to Maintain Data Integrity

All bathymetric data is moved through the Caris HIPS processing pipeline using a step-by-step method.
 Data integrity is maintained through the use of acquisition and processing logs, which track: acquisition of
 each line of data; conversion of the data; examination of ancillary sensor(navigation and attitude); and the
 application of heave, tides, SVP, and TPU. When processing an ERS survey, an additional log tracking the
 quality of SBETs is used.

B.2.1.4.2 Methods Used to Generate Bathymetric Grids

After initial processing the bathymetric data is gridded into BASE surfaces. VBES data is gridded using an
 Uncertainty Weighted algorithm. This type of surface calculates a horizontal and vertical uncertainty for
 each sounding, derived from the combined uncertainty from each of the sensors that contributes data to the
 sounding (e.g water levels, tide zoning, attitude sensor error, navigation sensor horizontal position error, and
 sound velocity profile error). Individual soundings are then propagated to grid nodes, which takes on a depth
 value as well as an uncertainty value based on all the soundings that contribute to the node. The influence of
 a sounding on a grid node is limited to 0.707 times the grid resolution.

MBES data is gridded using the CUBE algorithm. Resolution is dictated by the Project Instructions, as well
 as section 5.2.2 of the HSSD. The disambiguation method used is always Density and Local. The settings
 used for Capture Distance Scale, Horizontal Error Scale, and Capture Distance Minimum are those listed
 in section 4.2.1.1.1.1 of the FPM. After creation, Uncertainty and CUBE surfaces go through a quality
 control process. During this process, the Depth, Uncertainty, Standard Deviation, and Density child layers
 are examined for compliance with NOAA specifications. After the surfaces pass quality control, they are
 finalized. Uncertainty values for finalized surface come from the greater of either Uncertainty, or Standard
 Deviation.

B.2.1.4.3 Methods Used to Derive Final Depths

Methods Used

Cleaning Filters

Gridding Parameters

Surface Computation Algorithms

Description
Filters are used on a case-by-case basis as determined by the hydrographer. Refer
to the Descriptive Report for more information. Gridding parameters and surface
computation algorithms comply with the HSSD and are described above.

B.2.2 Imagery
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B.2.2.1 Side Scan Sonar

1) Convert raw .sdf data using Caris SIPS;
2) Scan Navigation and Attitude data, flagging erroneous data as rejected;
3) Re-compute towfish navigation. This is when tow point offsets and horizontal layback is applied to the
 data;
4) Slant range correct each line of data;
5) A primary reviewer scans each line for significant contacts;
6) A secondary reviewer makes an independent check-scan of all lines, verifying contacts and checking for
 missed contacts;
7) If the Project Instructions call for 200% Side Scan coverage, the scanners check correlation of contacts
 between 100% and 200% coverage;
8) Correlation is also used to reveal systematic errors, particularly if a contact shows up on lines collected in
 opposite or orthogonal directions;
9) Create individual mosaics for 100% and 200% coverage. Examine for coverage;
10) If necessary, create a holiday line plan.

Figure : This image intentionally left blank

B.2.2.2 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar imagery was not processed.

B.2.2.3 Specific Data Processing Methods

B.2.2.3.1 Methods Used to Maintain Data Integrity

Daily confidence checks were completed to ensure integrity of data. These checks were completed by
 ensonifing a target in the outer limits of the range scale on either side of towfish. When this target was seen
 on the trace within ten meters of the target's actual position (the positional accuracy of a towed system), it
 was understood that data integrity was maintained. Additionally, integrity is controlled through the use of
 acquisition and processing logs.

B.2.2.3.2 Methods Used to Achieve Object Detection and Accuracy Requirements

Object detection from side scan imagery is obtained by acquiring the entire survey area two times, with
 survey lines in the second coverage offset halfway between the lines from the first coverage. This results
 in 200% Side-Scan Coverage with line spacing based on 80% of the range scale. To ensure positional
 accuracy, a side scan certification test is performed. Multiple passes are made on a discrete feature (1m cube
 when possible) that ensonifies the feature with each transducer at a distance approximately 15%, 50%, and
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 80% of the range scale in use. A total of 12 passes are made and the feature must be detected in at least 10
 of the 12 pass. All survey lines are then processed and a contact created for the feature. Contact positions
 are plotted and compared to the actual position of the feature. The contacts must be within 5m of the actual
 position for hull-mounted systems and 10m for towed systems.

B.2.2.3.3 Methods Used to Verify Swath Coverage

Side scan sonar coverage is determined by creating mosaics using Mosaic Editor in Caris SIPS. Each 100%
 of coverage is evaluated independently for gaps in coverage. Any holidays noted in the mosaics must be re-
acquired in a manner that will ensonify the area from the same incidence angle as originally intended.

B.2.2.3.4 Criteria Used for Contact Selection

For water depths less than 20m, contact heights of 1m or greater are considered significant. For water depths
 20m or greater, contact heights of 10% of the water depth are considered significant. A feature is created for
 each significant contact.

B.2.2.3.5 Compression Methods Used for Reviewing Imagery

No compression methods were used for reviewing imagery.

B.2.3 Sound Speed

B.2.3.1 Sound Speed Profiles

Sound speed profiles are acquired by two types of devices: CTD and MVP. Downloading and processing of
 all sound speed data is performed using Velocipy, a part of the HSTP supplied Pydro program suite.

B.2.3.1.1 Specific Data Processing Methods

B.2.3.1.1.1 Caris SVP File Concatenation Methods

All sound speed profiles are concatenated into master files using Velocipy.

Figure : This image intentionally left blank

B.2.3.2 Surface Sound Speed

Surface sound speed data were not processed.
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B.2.4 Horizontal and Vertical Control

B.2.4.1 Horizontal Control

Realtime horizontal correctors are applied during acquisition from either USCG DGPS stations, or from
 the MarineStar satellite service.  In all cases, the necessary data for post processing of the position is
 recorded by the POS PCS into .000 files (when automatically split for file size, the file suffix increments
 to .001, .002, etc).  The post processing workflow varies based on using 5P (with the MarineStar service) or
 IAPPK (with DGPS).

MarineStar workflow:
1) Create a new project in POSPac MMS.
2) Drag all of the POS files into the new project window.
3) Wait for extraction and download of rapid ephemeris.
4) Run the GNSS-Inertial Processor. 
5) Export SBET files.

IAPPK workflow:
1) Create a new project in POSPac MMS.
2) Drag all of the POS files into the new project window.
3) Wait for extraction and download of ephemeris and CORS data.
4) Run the GNSS-Inertial Processor. 
5) Export SBET files.

While very similar, the two are very different in practice.  The primary requirement for running MarineStar
 through POSPac is to change the reference system of the data to NAD83, with the added benefit of reducing
 the uncertainty of the solution by running the processing both forward and backward.  For IAPPK, there is
 a time delay of around two days waiting on upload of the CORS data and availability of ephemeris.  Slow
 satellite internet download rates can make the download of CORS data prohibitively slow and prone to
 failure.  The reprocessing of the solution using the CORS data and recorded raw observables takes around
 two hours per 8 hour platform survey day, as compared to 10-15 minutes for the same processing via 5P.
  For “Thomas Jefferson,” with 24 hours of ship acquisition per day and two launch acquisition periods
 of 9 hours, the IAPPK processing typically takes 10 hours per day compared to about one hour for 5P
 processing.

Figure : This image intentionally left blank.

B.2.4.2 Vertical Control

Methods vary based on project assigned vertical control.
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If Zoned Tides or TCARI are assigned, all tidal data processing is done by CO-OPS.  Tides are then loaded
 in Caris or Pydro, respectively.

For ERS projects, a VDatum separation model (SEP) is provided with the Project Instructions.  This SEP
 and the GPS heights in the SBET exported from POSPac are combined in Caris using the Compute GPS
 Tides command.  Reduction to tidal datum is then completed by checking the "GPS Tides" option during the
 Merge step in Caris.

Figure : This image intentionally left blank.

B.2.5 Feature Verification

Feature verification begins during initial data processing. When conducting Side Scan surveys the data
 is converted and scanned for contacts using 2 independent reviewers. All significant contacts are then
 developed using a MBES. When conducting Multibeam surveys, or when reviewing MBES developments
 over side scan sonar contacts, the least depths over navigationally significant features are flagged as
 'designated soundings', then imported into Caris BASE Editor. Inside BASE Editor, each significant contact
 is given an S-57 attribution, and the hydrographer recommends charting action. The final deliverable is a
 Final Feature File (FFF) in .000 format.

Figure : This image intentionally left blank.

B.2.6 Backscatter

All backscatter data is logged in Hypack's .7k format, using datagram version 2. In accordance with the
 FPM, “Thomas Jefferson’s” policy is to process one line per platform, per day in order to conduct quality
 control checks. All processing of backscatter is done using the FMGT module of the QPS Fledermaus
 software package.

Figure : This image intentionally left blank.
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B.2.7 Other

No additional data were processed.

B.3 Quality Management

Prior to each field season, “Thomas Jefferson” and her survey launches perform an annual Hydrographic
 Survey Readiness Review, during which all multibeam echo sounders, vertical beam echo sounders, side
 scan sonars, positioning systems, sound speed measuring devices, lead lines, and leveling equipment are
 calibrated.

Prior to acquisition, the hydrographer ensures that all charted features and AWOIS items are in the
 Composite Source File (CSF), and reviews the coverage requirements. During daily acquisition, a
 hydrographer monitors the cumulative uncertainties in position and attitude data, watches incoming data
 for errors, and compares the surface sound speed against full water column data for each CTD cast. During
 post-processing, navigation and attitude data is scanned using Caris HIPS and SIPS. Side Scan data is
 then examined for significant features by two separate individuals. Multibeam data is binned into a BASE
 surface using the CUBE algorithm, then undergoes directed editing using the Standard Deviation, Depth,
 Uncertainty, and Hypothesis Count child layers. The HSSD allowed uncertainty is also calculated for each
 surface node, and compared against the actual uncertainty. Any systematic errors, problems in density, or
 areas of high uncertainty are addressed in the Descriptive Report. 

Before any data is to be submitted, it is reviewed by at least three experienced hydrographers who are
 signatories to the Descriptive Report.

B.4 Uncertainty and Error Management

Caris computes TPU based on both the static and dynamic measurements of the vessel and survey-specific
 information including tidal zoning uncertainty estimates and sound speed measurement uncertainties. Static
 offset values are entered into the Caris .hvf file. Dynamic (realtime) and sound speed uncertainties are
 entered using the Caris Compute TPU tool. Where TCARI tides are used, uncertainty is calculated and
 applied during application of TCARI tidal correctors to HDCS data.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
 included Appendix Folder, HVF Reports.  These HVF Reports are output from the Caris HVF Editor in a
 plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
 reproduce an HVF.
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B.4.1 Total Propagated Uncertainty (TPU)

B.4.1.1 TPU Calculation Methods

TPU is calculated in Caris HIPS using the Compute TPU tool. The uncertainty values for each input into the
 TPU model can come from one of three sources: Realtime, Static, or Vessel.  Realtime values are provided
 from the sensor or processing package, such as POSPac RMS files.  Static values are those entered manually
 into the Compute TPU dialog, such as tidal zoning uncertainty and sound speed measurement uncertainties.
  These Static values are documented in each sheet's Descriptive Report.  Vessel values are taken from the
 HVF if no realtime or static values are available. 

B.4.1.2 Source of TPU Values

Uncertainty values entered into the HVF for the multibeam and positioning systems were compiled from
 manufacturer specifications sheets for each sensor and from values set forth in section 4.2.3.8 and Appendix
 4 - Caris HVF Uncertainty Values of the 2014 FPM.  Sound speed static values are derived from the
 guidance in the FPM.  Tidal uncertainty values are realtime if using TCARI, or static and provided with the
 Project Instructions for Zoned Tides or VDatum.  Realtime values for the sonar are provided by the sonar. 
 Realtime values for motion and navigation are output from POSPac via the RMS file.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
included Appendix Folder, HVF Reports. These HVF Reports are output from the Caris HVF Editor in a
plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
reproduce an HVF.

B.4.1.3 TPU Values

Vessel n/a

Echosounder n/a n/a 0 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0 degrees

Heave
0 % Amplitude

0 meters

Pitch 0 degrees

Roll 0 degrees

Navigation
Position

0 meters
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Timing

Transducer 0 seconds

Navigation 0 seconds

Gyro 0 seconds

Heave 0 seconds

Pitch 0 seconds

Roll 0 seconds

Offsets

x 0 meters

y 0 meters

z 0 meters

MRU Alignment

Gyro 0 degrees

Pitch 0 degrees

Roll 0 degrees

Vessel

Speed 0 meters/second

Loading 0 meters

Draft 0 meters

Delta Draft 0 meters

B.4.2 Deviations

There were no deviations from the requirement to compute total propagated uncertainty.

C Corrections To Echo Soundings

C.1 Vessel Offsets and Layback

C.1.1 Vessel Offsets

C.1.1.1 Description of Correctors

See included HVFs for information on applied correctors.

C.1.1.2 Methods and Procedures

See included HVFs for information on applied correctors.

C.1.1.3 Vessel Offset Correctors
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Vessel See included HVFs for information on applied correctors.

Echosounder
See included HVFs for information on applied correctors. See included HVFs for
information on applied correctors. 0 hertz

Date 2015-11-13

Offsets

MRU to Transducer

x 0 meters

y 0 meters

z 0 meters

x2 0 meters

y2 0 meters

z2 0 meters

Nav to Transducer

x 0 meters

y 0 meters

z 0 meters

x2 0 meters

y2 0 meters

z2 0 meters

Transducer Roll
Roll 0 degrees

Roll2 0 radians

C.1.2 Layback

Layback correctors were not applied.

Additional Discussion

All offsets for “Thomas Jefferson” and her survey launches were derived from full or partial surveys
 performed by NGS personnel. All offsets are tracked and updated as needed.

All sensor offsets for “Thomas Jefferson” were measured with respect to the vessel's reference point,
 then translated to the IMU. The offsets for TJ3101 and TJ3102 are measured with respect to the vessel's
 IMU. Offset values are entered into each platform's Caris HIPS Hydrographic Vessel File (HVF), with the
 exception of the x,y,z offsets between the primary GPS antenna and the IMU. The distance between primary
 antenna and IMU is entered into POSView, which then feeds position relative to the IMU to all integrated
 sonars. All other offsets are applied to data during the SVP or Merge steps in processing of bathymetric
 data. Offsets are applied to side scan sonar data during the Recompute Towfish Navigation step.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
 included Appendix Folder, HVF Reports.  These HVF Reports are output from the Caris HVF Editor in a
 plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
 reproduce an HVF.
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Additional Discussion

Towfish positioning is provided to Caris HIPS using cable-out values registered by the Totco cable counter
 and recorded in the SonarPro SDF files. SonarPro uses Payout and Towfish Depth to compute towfish
 positions. The towfish position is calculated from the position of the tow point using the cable-out value
 received by SonarPro from the cable payout meter, the towfish pressure depth (sent via a serial interface
 from the Klein 5000 TPU to the SonarPro software), and the Course Made Good (CMG) of the vessel. This
 method assumes that the cable is in a straight line. Therefore, no catenary algorithm is applied at the time of
 acquisition, but in processing, Caris SIPS applies a 0.9 coefficient to account for the catenary.

Layback error is calculated by running a side scan certification test. This test consists of running parallel to
 a known feature at varying ranges from nadir to ensonify the target in the near-field (approximately 15% of
 range scale in use), mid-field (approximately 50 % of range scale in use), and far-field (approximately 85%
 of the range scale in use). The test requires that each side of the sonar ensonify the feature at each of these
 areas in the swath. Then the test is repeated in a direction that is orthogonal to the original set of lines such
 that the feature is ensonified a total of 12 times. A successful test will detect the feature in at least 10 of the
 12 passes. For hull-mounted systems, the selected contact positions must be within 5m; for towed systems,
 the contact positions must be within 10m. Layback error is the amount of correction that must be applied to
 minimize the distance between contact positions.

C.2 Static and Dynamic Draft

C.2.1 Static Draft

C.2.1.1 Description of Correctors

See Additional Discussion for information on static draft application.

C.2.1.2 Methods and Procedures

See Additional Discussion for information on static draft application.

C.2.2 Dynamic Draft

C.2.2.1 Description of Correctors

See Additional Discussion for information on dynamic draft application.

C.2.2.2 Methods and Procedures
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See Additional Discussion for information on dynamic draft application.

C.2.2.3 Dynamic Draft Correctors

Vessel 0

Date 2015-11-07

Dynamic
Draft Table

Speed Draft

0 0

Additional Discussion

Dynamic draft for “Thomas Jefferson” and her survey launches were measured using the Post Processed
 Kinematic GPS method outlined in section 1.4.2.1.2.1 of NOAA's FPM.  To reduce the effect of any
 potential current, reciprocal lines were run at each RPM step in order to get an average speed over ground
 for each RPM. This average speed was used to estimate the vessel’s speed through the water. Dynamic draft
 and vessel offsets corrector values are stored in the HIPS Vessel Files (HVF). 

In ERS surveys, those that use recorded GPS heights corrected via a VDatum SEP model to achieve tidal
 datum, the dynamic draft correction is not applied to the soundings.  

Dynamic draft on the Z-Boats was measured using a comparative method outlined in section B.2.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
 included Appendix Folder, HVF Reports.  These HVF Reports are output from the Caris HVF Editor in a
 plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
 reproduce an HVF.

Additional Discussion

Static draft for each survey launch is measured via a sight tube. For the ship, a Sutron Bubbler system is
 used to measure static draft. The orifice was surveyed into the IMU reference frame, and a waterline height
 was calculated. A common waterline for the ship when fully loaded with fuel and ballasted normally is
 approximately 35cm below the reference point of the ship, but the waterline may change by as much as +/-
 30cm over the course of a field season. On TJ3101 & TJ3102, the waterline is measured by placing a steel
 ruler directly on the reference mark and measuring directly from the sight tube. The waterline is almost
 constant on the launches despite fuel levels or normal loading. The normal range for waterline on each
 launch is 22.5cm to 23.5cm above the reference point.

In ERS surveys, the Static Draft is not applied to the soundings.  

Static draft on the Z-Boats was measured using a direct observation method outlined in section B.2.
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Waterline measurements are recorded daily on TJ3101 and TJ3102. The waterline for “Thomas Jefferson”
 is measured at least weekly. When feasible, waterline measurements are taken before and after fueling or
 ballasting of the ship. The values are kept in a static draft log and periodically updated in the HVF. Once
 applied in the HVF, all affected lines have SVP re-applied and are then merged so that the updated waterline
 measurements will be applied.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
 included Appendix Folder, HVF Reports.  These HVF Reports are output from the Caris HVF Editor in a
 plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
 reproduce an HVF.

C.3 System Alignment

System alignment correctors were not applied.

C.4 Positioning and Attitude

C.4.1 Description of Correctors

C.4.2 Methods and Procedures

Vessel navigation and attitude is measured by the POS/MV and recorded in the Hysweep .HSX file and .7k
 file. Navigation and attitude measurements not applied in real time are applied during post processing in
 Caris HIPS using the attitude data recorded in the .HSX or .s7k file. The POS/MV TrueHeave data is logged
 within the POS/MV .000 files and applied in Caris HIPS during post processing using the Import Ancillary
 Data command.  TrueHeave is a forward-backward filtered heave corrector as opposed to the real time
 heave corrector, and is fully described in section 6 of the POS/MV V4 User Guide 2009. In most cases,
 SBET files are applied to soundings to increase the accuracy of the kinematic vessel corrections and to
 allow the ability to reference soundings to the ellipsoid. Standard daily data processing procedures include
 post processing of POS/MV kinematic .000 files using Applanix POSPac MMS and POSGNSS software
 using either IN-Fusion SmartBase, IN-Fusion SingleBase or Omnistar Precise Point Positioning (a reference
 to the previous commercial name of Marinestar) processing modes. After processing and quality control
 analysis of the post-processed SBET files is complete, the SBET and RMS files are applied to the HDCS
 data in Caris HIPS using the Import Ancillary Data command.

Additional Discussion

As part of the annual HSRR, “Thomas Jefferson” conducted MBES calibration tests for each individual
 multibeam system on the ship and her launches. Multibeam systems with two frequencies required an
 individual test for each frequency. The procedure used follows that outlined in section 1.5.5.1 of the Field
 Procedures Manual dated April 2014. Timing bias was determined using the method of running the same
 line at different speeds. Pitch and yaw bias was determined using a target on the seafloor. Finally, roll bias
 was determined using the standard flat bottom method.
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Data was converted in Caris HIPS version using an HVF file with heave, pitch, roll and timing values set
 to zero. True heave, water levels, the most recent dynamic draft, and sound velocity were applied and the
 data merged. Biases were determined using the Caris HIPS Calibration tool and an average was determined.
  Bias values were determined in the following order; timing, pitch, roll, and finally yaw. These averaged
 values were established as the final correctors and were added to the Caris HVF.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
 included Appendix Folder, HVF Reports.  These HVF Reports are output from the Caris HVF Editor in a
 plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
 reproduce an HVF.

All calibration reports can be found in the Appendix Folder, Patch Test Reports.

C.5 Tides and Water Levels

C.5.1 Description of Correctors

Unless otherwise noted in the survey Descriptive Report (DR) or project Horizontal and Vertical Control
 Report (HVCR), the vertical datum for all soundings and heights is Mean Lower Low Water (MLLW).

C.5.2 Methods and Procedures

Reduction to MLLW is accomplished by a variety of means depending on the project.

Predicted, preliminary, and verified water level correctors from the primary tide station(s) listed in the
 Project Instructions may be downloaded from the CO-OPS website and used for water level corrections
 during the course of the project. These tide station files are collated to include the appropriate days of
 acquisition and then converted to Caris .tid file format using FetchTides. Water level data in the .tid files
 are applied to HDCS data in Caris HIPS using the zone definition file (.zdf) or, for TCARI, in Pydro using a
 TCARI model provided by CO-OPS.  Upon receiving final approved water level data, all data are reduced to
 MLLW using the final approved water levels as noted in the individual survey's Descriptive Report.

ERS surveys are reduced to MLLW via the application of the CO-OPS provided VDatum SEP model using
 the Compute GPS Tides tool in Caris.

A complete description of vertical control utilized for a given project can be found in the project specific
 HVCR, submitted for each project under separate cover when necessary as outlined in section 5.2.3.2.3 of
 the FPM.

C.6 Sound Speed
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C.6.1 Sound Speed Profiles

C.6.1.1 Description of Correctors

Aboard “Thomas Jefferson,” the MVP free-fall fish is used to collect sound speed profiles. Aboard TJ3101
 and TJ3102,  and-deployed seabird CTD units are used to take sound of speed profiles.

C.6.1.2 Methods and Procedures

Seabird .cnv and MVP .bot files are collected when necessary and converted to .svp files using NOAA's
 Pydro/Velocipy program. These .svp files are concatenated into one vessel specific master file per project
 which is then applied to HDCS data using a specified method. This method of applying sound speed to data
 is listed in the sheets processing log included in the Separates submitted with the individual survey.

C.6.2 Surface Sound Speed

C.6.2.1 Description of Correctors

Aboard “Thomas Jefferson,” surface sound speed is measured using a Reson SV-70 probe mounted inside
 a tank. The tank draws water from the approximate location of the face of the Reson 7125-ROV and Reson
 7125-SV2 transducer faces. TJ3101 and TJ3102 both use a Reson SV-71 probe mounted near the transducer
 face to measure the surface sound speed

C.6.2.2 Methods and Procedures

The speed of sound at the transducer face is fed directly to the Reson 7125-ROV and 7125-SV topside
 processing units. It is then passed to HYPACK/HYSWEEP, which records the value in the .HSX file.





Appendix I: Vessel Reports 

This appendix contains the HVF Reports generated from the Caris HVF Editor 
which contain all offsets and vessel specific values used in the calculation of TPU. 
Each sonar has its own HVF file for conversion into Caris, so there are multiple 
HVFs per hull.  

This appendix also contains the Dynamic Draft Reports for each vessel.  Each 
platform has only one Dynamic Draft Report, the outputs of which are applied to 
all HVFs that use that hull. 

 

 

  



Vessel Name: S222_Reson7125_ROV_400kHz_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-001 00:00

	 Comments: STB ROV 
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.180
	 Roll Offset:	 0.210
	 Azimuth Offset:	 -0.110

	 DeltaX:	 8.565
	 DeltaY:	 -2.617
	 DeltaZ:	 5.102

	 Manufacturer:	 Reson
	 Model:		   sb7125d
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Entry 0) Draft: 0.000	 Speed: 0.000
_________________________________________________________
Heave Sensor:



	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Apply Yes
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Apply Yes
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Apply Yes
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2015-001 00:00

	 Apply Yes
	 Comments: 
	 Time Correction(s) 0.000

	 Entry 1) Draft: -0.030	 Speed: 0.972
	 Entry 2) Draft: -0.050	 Speed: 1.944
	 Entry 3) Draft: -0.040	 Speed: 2.916



	 Entry 4) Draft: -0.010	 Speed: 3.888
	 Entry 5) Draft: 0.020	 Speed: 4.860
	 Entry 6) Draft: 0.060	 Speed: 5.832
	 Entry 7) Draft: 0.110	 Speed: 6.803
	 Entry 8) Draft: 0.160	 Speed: 7.775
	 Entry 9) Draft: 0.210	 Speed: 8.747
	 Entry 10) Draft: 0.260	 Speed: 9.719
	 Entry 11) Draft: 0.290	 Speed: 10.691
_________________________________________________________
TPU

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 8.565
		  Y Head 1 -2.617
		  Z Head 1 5.102
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1
		  X Head 1 7.267
		  Y Head 1 7.359
		  Z Head 1 27.522
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.000
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.020 or 2.000'' of heave amplitude.
	 Measurement errors: 0.020
	 Motion sensing unit alignment errors
	 Gyro:0.060	 Pitch:0.030	 Roll:0.030
	 Gyro measurement error: 0.015
	 Roll measurement error: 0.005
	 Pitch measurement error: 0.005
	 Navigation measurement error: 0.500
	 Transducer timing error: 0.003
	 Navigation timing error: 0.003
	 Gyro timing error: 0.003
	 Heave timing error: 0.003
	 PitchTimingStdDev: 0.003
	 Roll timing error: 0.003
	 Sound Velocity speed measurement error: 0.000
	 Surface sound speed measurement error: 0.000
	 Tide measurement error: 0.000
	 Tide zoning error: 0.000



	 Speed over ground measurement error: 0.100
	 Dynamic loading measurement error: 0.030
	 Static draft measurement error: 0.030
	 Delta draft measurement error: 0.020
	 StDev Comment: (null)
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 8.565
	 DeltaY:	 -2.617
	 DeltaZ:	 5.102

	 SVP #2:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-001 00:00

	 Comments: from bubbler gauge
	 Apply Yes
	 WaterLine 0.320

	 Time Stamp:	  2015-117 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.381

	 Time Stamp:	  2015-118 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.374



	 Time Stamp:	  2015-119 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.379

	 Time Stamp:	  2015-124 00:00

	 Comments: Measured with the HSL's off and on after fuel transfer. Made no difference.
	 Apply Yes
	 WaterLine 0.450

	 Time Stamp:	  2015-131 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.430

	 Time Stamp:	  2015-148 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.449

	 Time Stamp:	  2015-155 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.532

	 Time Stamp:	  2015-166 00:00

	 Comments: With Launches on and after considerable balasting during Charleston  port call.
	 Apply Yes
	 WaterLine 0.440
_________________________________________________________



Vessel Name: S222_Reson7125_SV2_200kHz_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-001 00:00

	 Comments: PORT SV2, offsets from 2014 NGS survey.  Z value modified by 2014 leadline
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.150
	 Roll Offset:	 0.090
	 Azimuth Offset:	 -1.040

	 DeltaX:	 -3.582
	 DeltaY:	 -2.831
	 DeltaZ:	 5.096

	 Manufacturer:	 Reson
	 Model:		   sb7125b
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

_________________________________________________________
Heave Sensor:

	 Time Stamp:	  2015-001 00:00



	 Comments: 
	 Apply Yes
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Apply Yes
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Apply Yes
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2015-001 00:00

	 Apply Yes
	 Comments: 
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: -0.030	 Speed: 0.972
	 Entry 3) Draft: -0.050	 Speed: 1.944
	 Entry 4) Draft: -0.040	 Speed: 2.916



	 Entry 5) Draft: -0.010	 Speed: 3.888
	 Entry 6) Draft: 0.020	 Speed: 4.860
	 Entry 7) Draft: 0.060	 Speed: 5.832
	 Entry 8) Draft: 0.110	 Speed: 6.803
	 Entry 9) Draft: 0.160	 Speed: 7.775
	 Entry 10) Draft: 0.210	 Speed: 8.747
	 Entry 11) Draft: 0.260	 Speed: 9.719
	 Entry 12) Draft: 0.290	 Speed: 10.691
_________________________________________________________
TPU

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 -3.582
		  Y Head 1 -2.831
		  Z Head 1 5.096
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1
		  X Head 1 -4.880
		  Y Head 1 7.145
		  Z Head 1 27.516
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.000
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.020 or 2.000'' of heave amplitude.
	 Measurement errors: 0.020
	 Motion sensing unit alignment errors
	 Gyro:0.050	 Pitch:0.030	 Roll:0.030
	 Gyro measurement error: 0.015
	 Roll measurement error: 0.005
	 Pitch measurement error: 0.005
	 Navigation measurement error: 0.500
	 Transducer timing error: 0.003
	 Navigation timing error: 0.003
	 Gyro timing error: 0.003
	 Heave timing error: 0.003
	 PitchTimingStdDev: 0.003
	 Roll timing error: 0.003
	 Sound Velocity speed measurement error: 0.000
	 Surface sound speed measurement error: 0.000
	 Tide measurement error: 0.000
	 Tide zoning error: 0.000



	 Speed over ground measurement error: 0.100
	 Dynamic loading measurement error: 0.030
	 Static draft measurement error: 0.030
	 Delta draft measurement error: 0.020
	 StDev Comment: (null)
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 -3.582
	 DeltaY:	 -2.831
	 DeltaZ:	 5.096

	 SVP #2:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-001 00:00

	 Comments: From Younkin 4/28/2015 Bubbler Avg
	 Apply Yes
	 WaterLine 0.380

	 Time Stamp:	  2015-117 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.381

	 Time Stamp:	  2015-118 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.374



	 Time Stamp:	  2015-119 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.379

	 Time Stamp:	  2015-124 00:00

	 Comments: Measured with HSL's on and off after fuel transfer. Made no difference if HSL's were on.
	 Apply Yes
	 WaterLine 0.450

	 Time Stamp:	  2015-131 00:00

	 Comments: No HSL's
	 Apply Yes
	 WaterLine 0.430

	 Time Stamp:	  2015-148 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.449

	 Time Stamp:	  2015-155 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.532

	 Time Stamp:	  2015-166 00:00

	 Comments: With HSL's, after ballasting during Charleston port call. 
	 Apply Yes
	 WaterLine 0.441
_________________________________________________________



Vessel Name: S222_Reson7125_SV2_400kHz_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-001 00:00

	 Comments: PORT SV2, offsets from 2014 NGS survey.  Z value modified by 2014 leadline
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.100
	 Roll Offset:	 0.070
	 Azimuth Offset:	 -1.020

	 DeltaX:	 -3.582
	 DeltaY:	 -2.831
	 DeltaZ:	 5.096

	 Manufacturer:	 Reson
	 Model:		   sb7125d
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

_________________________________________________________
Heave Sensor:

	 Time Stamp:	  2015-001 00:00



	 Comments: 
	 Apply Yes
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Apply Yes
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Apply Yes
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2015-001 00:00

	 Apply Yes
	 Comments: 
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: -0.030	 Speed: 0.972
	 Entry 3) Draft: -0.050	 Speed: 1.944
	 Entry 4) Draft: -0.040	 Speed: 2.916



	 Entry 5) Draft: -0.010	 Speed: 3.888
	 Entry 6) Draft: 0.020	 Speed: 4.860
	 Entry 7) Draft: 0.060	 Speed: 5.832
	 Entry 8) Draft: 0.110	 Speed: 6.803
	 Entry 9) Draft: 0.160	 Speed: 7.775
	 Entry 10) Draft: 0.210	 Speed: 8.747
	 Entry 11) Draft: 0.260	 Speed: 9.719
	 Entry 12) Draft: 0.290	 Speed: 10.691
_________________________________________________________
TPU

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 -3.582
		  Y Head 1 -2.831
		  Z Head 1 5.096
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1
		  X Head 1 -4.880
		  Y Head 1 7.145
		  Z Head 1 27.516
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.000
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.020 or 2.000'' of heave amplitude.
	 Measurement errors: 0.020
	 Motion sensing unit alignment errors
	 Gyro:0.030	 Pitch:0.010	 Roll:0.010
	 Gyro measurement error: 0.015
	 Roll measurement error: 0.005
	 Pitch measurement error: 0.005
	 Navigation measurement error: 0.500
	 Transducer timing error: 0.003
	 Navigation timing error: 0.003
	 Gyro timing error: 0.003
	 Heave timing error: 0.003
	 PitchTimingStdDev: 0.003
	 Roll timing error: 0.003
	 Sound Velocity speed measurement error: 0.000
	 Surface sound speed measurement error: 0.000
	 Tide measurement error: 0.000
	 Tide zoning error: 0.000



	 Speed over ground measurement error: 0.100
	 Dynamic loading measurement error: 0.030
	 Static draft measurement error: 0.030
	 Delta draft measurement error: 0.020
	 StDev Comment: (null)
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 -3.582
	 DeltaY:	 -2.831
	 DeltaZ:	 5.096

	 SVP #2:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-001 00:00

	 Comments: From Younkin 4/28/2015 Bubbler Average
	 Apply Yes
	 WaterLine 0.380

	 Time Stamp:	  2015-117 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.381

	 Time Stamp:	  2015-118 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.374



	 Time Stamp:	  2015-119 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.398

	 Time Stamp:	  2015-124 00:00

	 Comments: Measured with HSL's on and off after fuel transfer. Made no difference if HSL's were on.
	 Apply Yes
	 WaterLine 0.450

	 Time Stamp:	  2015-131 00:00

	 Comments: No HSL's
	 Apply Yes
	 WaterLine 0.430

	 Time Stamp:	  2015-148 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.449

	 Time Stamp:	  2015-155 00:00

	 Comments: 
	 Apply Yes
	 WaterLine 0.532

	 Time Stamp:	  2015-166 00:00

	 Comments: With HSL's, after ballasting during Charleston port call. 
	 Apply Yes
	 WaterLine 0.441
_________________________________________________________



Vessel Name: TJ_3101_Klein5KLT_Hull_100_2015.hvf
Vessel created: June 23, 2015

Navigation Sensor:

	 Time Stamp:	  2010-101 00:00

	 Comments: New Installation
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 Applanix
	 Model:		   POS MV V4
	 Serial Number:	  ???

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2010-101 00:00

	 Comments: New Installation
	 Time Correction(s) 0.000

	 Entry 0) Draft: 0.000	 Speed: 0.000
	 Entry 1) Draft: 180.000	 Speed: 0.000
_________________________________________________________
Tow Point:

	 Time Stamp:	  2010-101 00:00

	 Comments: New installation Klein 500 LT WT
	 Time Correction(s) 0.000
	 DeltaX:	 0.494
	 DeltaY:	 0.054
	 DeltaZ:	 0.600

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  322

	 Time Stamp:	  2010-101 00:10

	 Comments: SSS tow pt to WL adjustment
	 Time Correction(s) 0.000
	 DeltaX:	 0.494
	 DeltaY:	 0.054
	 DeltaZ:	 -0.832

	 Manufacturer:	 Klein



	 Model:		   5000
	 Serial Number:	  322

	 Time Stamp:	  2010-301 00:00

	 Comments: 100 m intended for range scale was entered into cable out - this entry corrects the error.
	 Time Correction(s) 0.000
	 DeltaX:	 0.494
	 DeltaY:	 0.054
	 DeltaZ:	 -0.832

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  322

	 Time Stamp:	  2010-301 22:00

	 Comments: Towpoint returned to normal position once 100m cable out issue was resolved.
	 Time Correction(s) 0.000
	 DeltaX:	 0.494
	 DeltaY:	 0.054
	 DeltaZ:	 -0.832

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  322

	 Time Stamp:	  2015-001 00:00

	 Comments: Testing 3102's towpoint values. ACL
	 Time Correction(s) 0.000
	 DeltaX:	 0.494
	 DeltaY:	 0.054
	 DeltaZ:	 0.832

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  322

_________________________________________________________
WaterLine:

	 Time Stamp:	  2010-096 00:00

	 Comments: ches Bay
	 Apply Yes
	 WaterLine -0.235
_________________________________________________________



Vessel Name: TJ_3101_Klein5KLT_Hull_200_2015.hvf
Vessel created: June 23, 2015

Navigation Sensor:

	 Time Stamp:	  2010-101 00:00

	 Comments: New Installation
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 Applanix
	 Model:		   POS MV V4
	 Serial Number:	  ???

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2010-101 00:00

	 Comments: New Installation
	 Time Correction(s) 0.000

	 Entry 0) Draft: 0.000	 Speed: 0.000
	 Entry 1) Draft: 180.000	 Speed: 0.000
_________________________________________________________
Tow Point:

	 Time Stamp:	  2010-101 00:00

	 Comments: New installation Klein 500 LT WT
	 Time Correction(s) 0.000
	 DeltaX:	 0.494
	 DeltaY:	 0.054
	 DeltaZ:	 0.600

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  322

	 Time Stamp:	  2010-101 00:10

	 Comments: SSS tow pt to WL adjustment
	 Time Correction(s) 0.000
	 DeltaX:	 0.494
	 DeltaY:	 0.054
	 DeltaZ:	 -0.832

	 Manufacturer:	 Klein



	 Model:		   5000
	 Serial Number:	  322

	 Time Stamp:	  2015-001 00:00

	 Comments: Tow pt determined to be positive
	 Time Correction(s) 0.000
	 DeltaX:	 0.494
	 DeltaY:	 0.054
	 DeltaZ:	 0.832

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  322

_________________________________________________________
WaterLine:

	 Time Stamp:	  2010-096 00:00

	 Comments: ches Bay
	 Apply Yes
	 WaterLine -0.235
_________________________________________________________



Vessel Name: TJ_3101_Reson7125_SV2_200kHz_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 1.080
	 Roll Offset:	 -0.470
	 Azimuth Offset:	 0.130

	 DeltaX:	 -0.425
	 DeltaY:	 0.001
	 DeltaZ:	 0.558

	 Manufacturer:	 
	 Model:		   sb7125b
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000

_________________________________________________________
Heave Sensor:

	 Time Stamp:	  2015-001 00:00



	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2015-001 00:00

	 Apply Yes
	 Comments: (null)
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: 0.010	 Speed: 0.972
	 Entry 3) Draft: 0.020	 Speed: 1.944
	 Entry 4) Draft: 0.030	 Speed: 2.916



	 Entry 5) Draft: 0.040	 Speed: 3.888
	 Entry 6) Draft: 0.050	 Speed: 4.860
	 Entry 7) Draft: 0.060	 Speed: 5.832
	 Entry 8) Draft: 0.060	 Speed: 6.803
	 Entry 9) Draft: 0.060	 Speed: 7.775
	 Entry 10) Draft: 0.050	 Speed: 8.747
	 Entry 11) Draft: 0.040	 Speed: 9.719
	 Entry 12) Draft: 0.020	 Speed: 10.691
	 Entry 13) Draft: -0.010	 Speed: 11.663
	 Entry 14) Draft: -0.050	 Speed: 12.635
	 Entry 15) Draft: -0.090	 Speed: 13.607
_________________________________________________________
TPU

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 -0.425
		  Y Head 1 0.001
		  Z Head 1 0.558
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1
		  X Head 1 0.274
		  Y Head 1 0.844
		  Z Head 1 4.342
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.000
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.020 or 2.000'' of heave amplitude.
	 Measurement errors: 0.020
	 Motion sensing unit alignment errors
	 Gyro:0.050	 Pitch:0.100	 Roll:0.100
	 Gyro measurement error: 0.015
	 Roll measurement error: 0.005
	 Pitch measurement error: 0.005
	 Navigation measurement error: 0.500
	 Transducer timing error: 0.003
	 Navigation timing error: 0.003
	 Gyro timing error: 0.003
	 Heave timing error: 0.003
	 PitchTimingStdDev: 0.003
	 Roll timing error: 0.003
	 Sound Velocity speed measurement error: 0.000



	 Surface sound speed measurement error: 0.000
	 Tide measurement error: 0.000
	 Tide zoning error: 0.000
	 Speed over ground measurement error: 0.100
	 Dynamic loading measurement error: 0.030
	 Static draft measurement error: 0.030
	 Delta draft measurement error: 0.020
	 StDev Comment: (null)
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 -0.425
	 DeltaY:	 0.001
	 DeltaZ:	 0.558

	 SVP #2:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 WaterLine -0.220
_________________________________________________________



Vessel Name: TJ_3101_Reson7125_SV2_400kHz_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 1.240
	 Roll Offset:	 -0.550
	 Azimuth Offset:	 0.240

	 DeltaX:	 -0.425
	 DeltaY:	 0.001
	 DeltaZ:	 0.558

	 Manufacturer:	 
	 Model:		   sb7125d
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000

_________________________________________________________
Heave Sensor:

	 Time Stamp:	  2015-001 00:00



	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2015-001 00:00

	 Apply Yes
	 Comments: (null)
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: 0.010	 Speed: 0.972
	 Entry 3) Draft: 0.020	 Speed: 1.944
	 Entry 4) Draft: 0.030	 Speed: 2.916



	 Entry 5) Draft: 0.040	 Speed: 3.888
	 Entry 6) Draft: 0.050	 Speed: 4.860
	 Entry 7) Draft: 0.060	 Speed: 5.832
	 Entry 8) Draft: 0.060	 Speed: 6.803
	 Entry 9) Draft: 0.060	 Speed: 7.775
	 Entry 10) Draft: 0.050	 Speed: 8.747
	 Entry 11) Draft: 0.040	 Speed: 9.719
	 Entry 12) Draft: 0.020	 Speed: 10.691
	 Entry 13) Draft: -0.010	 Speed: 11.663
	 Entry 14) Draft: -0.050	 Speed: 12.635
	 Entry 15) Draft: -0.090	 Speed: 13.607
_________________________________________________________
TPU

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 -0.425
		  Y Head 1 0.001
		  Z Head 1 0.558
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1
		  X Head 1 0.274
		  Y Head 1 0.844
		  Z Head 1 4.342
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.000
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.020 or 2.000'' of heave amplitude.
	 Measurement errors: 0.020
	 Motion sensing unit alignment errors
	 Gyro:0.080	 Pitch:0.110	 Roll:0.110
	 Gyro measurement error: 0.015
	 Roll measurement error: 0.005
	 Pitch measurement error: 0.005
	 Navigation measurement error: 0.500
	 Transducer timing error: 0.003
	 Navigation timing error: 0.003
	 Gyro timing error: 0.003
	 Heave timing error: 0.003
	 PitchTimingStdDev: 0.003
	 Roll timing error: 0.003
	 Sound Velocity speed measurement error: 0.000



	 Surface sound speed measurement error: 0.000
	 Tide measurement error: 0.000
	 Tide zoning error: 0.000
	 Speed over ground measurement error: 0.100
	 Dynamic loading measurement error: 0.030
	 Static draft measurement error: 0.030
	 Delta draft measurement error: 0.020
	 StDev Comment: (null)
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 -0.425
	 DeltaY:	 0.001
	 DeltaZ:	 0.558

	 SVP #2:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 WaterLine -0.220
_________________________________________________________



Vessel Name: TJ_3102_Klein5KLT_Hull_100.hvf
Vessel created: June 23, 2015

Navigation Sensor:

	 Time Stamp:	  2010-067 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

	 Time Stamp:	  2013-147 00:00

	 Comments: 
	 Time Correction(s) -2.500
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 
	 Model:		   
	 Serial Number:	  

	 Time Stamp:	  2013-148 16:20

	 Comments: 
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 
	 Model:		   
	 Serial Number:	  

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2010-067 00:00

	 Comments: 
	 Time Correction(s) 0.000

_________________________________________________________



Tow Point:

	 Time Stamp:	  2010-067 00:00

	 Comments: New Installation NGS position
	 Time Correction(s) 0.000
	 DeltaX:	 0.463
	 DeltaY:	 -0.020
	 DeltaZ:	 0.617

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  319

	 Time Stamp:	  2010-067 00:10

	 Comments: Towpoint to waterline configuration
	 Time Correction(s) 0.000
	 DeltaX:	 0.463
	 DeltaY:	 -0.020
	 DeltaZ:	 -0.852

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  319

	 Time Stamp:	  2013-147 00:00

	 Comments: Layback error
	 Time Correction(s) 0.000
	 DeltaX:	 0.463
	 DeltaY:	 100.020
	 DeltaZ:	 -0.852

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  319

	 Time Stamp:	  2013-148 16:20

	 Comments: normal layvack check time
	 Time Correction(s) 0.000
	 DeltaX:	 0.463
	 DeltaY:	 -0.020
	 DeltaZ:	 -0.852

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  319

_________________________________________________________



WaterLine:

	 Time Stamp:	  2010-067 00:00

	 Comments: Needed for  SSS algorithim
	 Apply Yes
	 WaterLine -0.235
_________________________________________________________



Vessel Name: TJ_3102_Klein5KLT_Hull_200_2015.hvf
Vessel created: June 23, 2015

Navigation Sensor:

	 Time Stamp:	  2010-067 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

	 Time Stamp:	  2013-147 00:00

	 Comments: 
	 Time Correction(s) -2.500
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 
	 Model:		   
	 Serial Number:	  

	 Time Stamp:	  2013-148 16:20

	 Comments: 
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 
	 Model:		   
	 Serial Number:	  

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2010-067 00:00

	 Comments: 
	 Time Correction(s) 0.000

_________________________________________________________



Tow Point:

	 Time Stamp:	  2010-067 00:00

	 Comments: New Installation NGS position
	 Time Correction(s) 0.000
	 DeltaX:	 0.463
	 DeltaY:	 -0.020
	 DeltaZ:	 0.617

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  319

	 Time Stamp:	  2010-067 00:10

	 Comments: Towpoint to waterline configuration
	 Time Correction(s) 0.000
	 DeltaX:	 0.463
	 DeltaY:	 -0.020
	 DeltaZ:	 -0.852

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  319

	 Time Stamp:	  2013-147 00:00

	 Comments: Layback error
	 Time Correction(s) 0.000
	 DeltaX:	 0.463
	 DeltaY:	 100.020
	 DeltaZ:	 -0.852

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  319

	 Time Stamp:	  2013-148 16:20

	 Comments: normal layvack check time
	 Time Correction(s) 0.000
	 DeltaX:	 0.463
	 DeltaY:	 -0.020
	 DeltaZ:	 -0.852

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  319



	 Time Stamp:	  2015-001 00:00

	 Comments: Z is positive down
	 Time Correction(s) 0.000
	 DeltaX:	 0.463
	 DeltaY:	 -0.020
	 DeltaZ:	 0.852

	 Manufacturer:	 Klein
	 Model:		   5000
	 Serial Number:	  319

_________________________________________________________
WaterLine:

	 Time Stamp:	  2010-067 00:00

	 Comments: Needed for  SSS algorithim
	 Apply Yes
	 WaterLine -0.235

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Apply Yes
	 WaterLine -0.235
_________________________________________________________



Vessel Name: TJ_3102_Odom_VB_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2008-001 00:00

	 Comments: Installed DN100
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.600
	 Roll Offset:	 -0.120
	 Azimuth Offset:	 -0.230

	 DeltaX:	 -0.879
	 DeltaY:	 0.076
	 DeltaZ:	 0.611

	 Manufacturer:	 ODOM
	 Model:		   oemk2
	 Serial Number:	  31381

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2005-207 00:00

	 Comments: M FORD - NEW LAUNCHES PATCH AUG 05
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 Applanix
	 Model:		   POS/MV V4
	 Serial Number:	  2207

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2007-001 00:00

	 Comments: Start of Field Season '07
	 Time Correction(s) 0.000

_________________________________________________________
Heave Sensor:

	 Time Stamp:	  2007-001 00:00



	 Comments: Start of Field Season '07
	 Apply Yes
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000

	 Manufacturer:	 Applanix
	 Model:		   POS/MV V4
	 Serial Number:	  2207

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2007-001 00:00

	 Comments: Start of Field Season '07
	 Apply Yes
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 Applanix
	 Model:		   POS/MV V4
	 Serial Number:	  2207

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2007-001 00:00

	 Comments: Start of Field Season '07
	 Apply Yes
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 Applanix
	 Model:		   POS/MV V4
	 Serial Number:	  2207

_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2007-087 00:00

	 Apply Yes
	 Comments: 2007 HSRR results
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: 0.000	 Speed: 1.994
	 Entry 3) Draft: 0.038	 Speed: 6.592
	 Entry 4) Draft: 0.082	 Speed: 7.550



	 Entry 5) Draft: 0.052	 Speed: 8.364
	 Entry 6) Draft: 0.036	 Speed: 9.027
	 Entry 7) Draft: 0.036	 Speed: 15.551

	 Time Stamp:	  2008-086 00:00

	 Apply Yes
	 Comments: 2008 HSRR results
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 1.989
	 Entry 2) Draft: 0.030	 Speed: 5.511
	 Entry 3) Draft: 0.038	 Speed: 6.592
	 Entry 4) Draft: 0.082	 Speed: 7.550
	 Entry 5) Draft: 0.052	 Speed: 8.364
	 Entry 6) Draft: 0.036	 Speed: 9.027

	 Time Stamp:	  2015-001 00:00

	 Apply Yes
	 Comments: 2015 HSRR
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.010	 Speed: 0.972
	 Entry 2) Draft: 0.020	 Speed: 1.944
	 Entry 3) Draft: 0.030	 Speed: 2.916
	 Entry 4) Draft: 0.040	 Speed: 3.888
	 Entry 5) Draft: 0.050	 Speed: 4.860
	 Entry 6) Draft: 0.060	 Speed: 5.832
	 Entry 7) Draft: 0.060	 Speed: 6.803
	 Entry 8) Draft: 0.060	 Speed: 7.775
	 Entry 9) Draft: 0.050	 Speed: 8.747
	 Entry 10) Draft: 0.040	 Speed: 9.719
	 Entry 11) Draft: 0.020	 Speed: 10.691
	 Entry 12) Draft: -0.010	 Speed: 11.663
	 Entry 13) Draft: -0.050	 Speed: 12.635
	 Entry 14) Draft: -0.090	 Speed: 13.607
_________________________________________________________
TPU

	 Time Stamp:	  2007-001 00:01

	 Comments: Start of Field Season '07
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 0.379
		  Y Head 1 0.116
		  Z Head 1 0.600
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1



		  X Head 1 0.332
		  Y Head 1 0.750
		  Z Head 1 4.389
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.550
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.050 or 5.000'' of heave amplitude.
	 Measurement errors: 0.002
	 Motion sensing unit alignment errors
	 Gyro:0.000	 Pitch:0.000	 Roll:0.000
	 Gyro measurement error: 0.020
	 Roll measurement error: 0.050
	 Pitch measurement error: 0.050
	 Navigation measurement error: 0.500
	 Transducer timing error: 0.001
	 Navigation timing error: 0.001
	 Gyro timing error: 0.001
	 Heave timing error: 0.001
	 PitchTimingStdDev: 0.001
	 Roll timing error: 0.001
	 Sound Velocity speed measurement error: 0.500
	 Surface sound speed measurement error: 0.500
	 Tide measurement error: 0.010
	 Tide zoning error: 0.200
	 Speed over ground measurement error: 0.030
	 Dynamic loading measurement error: 0.000
	 Static draft measurement error: 0.010
	 Delta draft measurement error: -0.054
	 StDev Comment: (null)
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2008-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 -0.879
	 DeltaY:	 0.076
	 DeltaZ:	 0.611

	 SVP #2:
	 -------------



	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2008-001 00:00

	 Comments: Start of Field Season '07
	 Apply No
	 WaterLine 0.000

	 Time Stamp:	  2008-086 00:00

	 Comments: HSRR_2008
	 Apply Yes
	 WaterLine -0.220
_________________________________________________________



Vessel Name: TJ_3101_Reson7125_SV2_200kHz_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 1.080
	 Roll Offset:	 -0.470
	 Azimuth Offset:	 0.130

	 DeltaX:	 -0.425
	 DeltaY:	 0.001
	 DeltaZ:	 0.558

	 Manufacturer:	 
	 Model:		   sb7125b
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000

_________________________________________________________
Heave Sensor:

	 Time Stamp:	  2015-001 00:00



	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2015-001 00:00

	 Apply Yes
	 Comments: (null)
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: 0.010	 Speed: 0.972
	 Entry 3) Draft: 0.020	 Speed: 1.944
	 Entry 4) Draft: 0.030	 Speed: 2.916



	 Entry 5) Draft: 0.040	 Speed: 3.888
	 Entry 6) Draft: 0.050	 Speed: 4.860
	 Entry 7) Draft: 0.060	 Speed: 5.832
	 Entry 8) Draft: 0.060	 Speed: 6.803
	 Entry 9) Draft: 0.060	 Speed: 7.775
	 Entry 10) Draft: 0.050	 Speed: 8.747
	 Entry 11) Draft: 0.040	 Speed: 9.719
	 Entry 12) Draft: 0.020	 Speed: 10.691
	 Entry 13) Draft: -0.010	 Speed: 11.663
	 Entry 14) Draft: -0.050	 Speed: 12.635
	 Entry 15) Draft: -0.090	 Speed: 13.607
_________________________________________________________
TPU

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 -0.425
		  Y Head 1 0.001
		  Z Head 1 0.558
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1
		  X Head 1 0.274
		  Y Head 1 0.844
		  Z Head 1 4.342
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.000
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.020 or 2.000'' of heave amplitude.
	 Measurement errors: 0.020
	 Motion sensing unit alignment errors
	 Gyro:0.050	 Pitch:0.100	 Roll:0.100
	 Gyro measurement error: 0.015
	 Roll measurement error: 0.005
	 Pitch measurement error: 0.005
	 Navigation measurement error: 0.500
	 Transducer timing error: 0.003
	 Navigation timing error: 0.003
	 Gyro timing error: 0.003
	 Heave timing error: 0.003
	 PitchTimingStdDev: 0.003
	 Roll timing error: 0.003
	 Sound Velocity speed measurement error: 0.000



	 Surface sound speed measurement error: 0.000
	 Tide measurement error: 0.000
	 Tide zoning error: 0.000
	 Speed over ground measurement error: 0.100
	 Dynamic loading measurement error: 0.030
	 Static draft measurement error: 0.030
	 Delta draft measurement error: 0.020
	 StDev Comment: (null)
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 -0.425
	 DeltaY:	 0.001
	 DeltaZ:	 0.558

	 SVP #2:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 WaterLine -0.220
_________________________________________________________



Vessel Name: TJ_3102_Reson7125_400kHz_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.540
	 Roll Offset:	 -1.180
	 Azimuth Offset:	 -0.800

	 DeltaX:	 -0.428
	 DeltaY:	 -0.081
	 DeltaZ:	 0.556

	 Manufacturer:	 
	 Model:		   sb7125d
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000

	 Entry 0) Draft: 0.000	 Speed: 0.000
_________________________________________________________
Heave Sensor:



	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2015-001 00:00

	 Apply Yes
	 Comments: (null)
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: 0.010	 Speed: 0.972
	 Entry 3) Draft: 0.020	 Speed: 1.944



	 Entry 4) Draft: 0.030	 Speed: 2.916
	 Entry 5) Draft: 0.040	 Speed: 3.888
	 Entry 6) Draft: 0.050	 Speed: 4.860
	 Entry 7) Draft: 0.060	 Speed: 5.832
	 Entry 8) Draft: 0.060	 Speed: 6.803
	 Entry 9) Draft: 0.060	 Speed: 7.775
	 Entry 10) Draft: 0.050	 Speed: 8.747
	 Entry 11) Draft: 0.040	 Speed: 9.719
	 Entry 12) Draft: 0.020	 Speed: 10.691
	 Entry 13) Draft: -0.010	 Speed: 11.663
	 Entry 14) Draft: -0.050	 Speed: 12.635
	 Entry 15) Draft: -0.090	 Speed: 13.607
_________________________________________________________
TPU

	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 -0.428
		  Y Head 1 -0.081
		  Z Head 1 0.556
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1
		  X Head 1 0.398
		  Y Head 1 0.918
		  Z Head 1 4.373
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.000
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.020 or 2.000'' of heave amplitude.
	 Measurement errors: 0.020
	 Motion sensing unit alignment errors
	 Gyro:0.140	 Pitch:0.060	 Roll:0.060
	 Gyro measurement error: 0.015
	 Roll measurement error: 0.005
	 Pitch measurement error: 0.005
	 Navigation measurement error: 0.500
	 Transducer timing error: 0.003
	 Navigation timing error: 0.003
	 Gyro timing error: 0.003
	 Heave timing error: 0.003
	 PitchTimingStdDev: 0.003
	 Roll timing error: 0.003



	 Sound Velocity speed measurement error: 0.000
	 Surface sound speed measurement error: 0.000
	 Tide measurement error: 0.000
	 Tide zoning error: 0.000
	 Speed over ground measurement error: 0.100
	 Dynamic loading measurement error: 0.030
	 Static draft measurement error: 0.030
	 Delta draft measurement error: 0.020
	 StDev Comment: (null)
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 -0.428
	 DeltaY:	 -0.081
	 DeltaZ:	 0.556

	 SVP #2:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply Yes
	 WaterLine -0.220
_________________________________________________________



Vessel Name: TJ_S222_Klein5000_SSS100_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 
	 Model:		   Unknown
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 Applanix
	 Model:		   v4
	 Serial Number:	  (null)

_________________________________________________________
Heave Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply No
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000



	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply No
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply No
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Tow Point:

	 Time Stamp:	  2015-001 00:00

	 Comments: HSRR 2015
	 Time Correction(s) 0.000
	 DeltaX:	 6.370
	 DeltaY:	 -42.550
	 DeltaZ:	 -4.800

	 Manufacturer:	 Klein
	 Model:		   5000 V2
	 Serial Number:	  

	 Time Stamp:	  2015-117 00:00

	 Comments: HSRR 2015 SSS Cert Results
	 Time Correction(s) 0.000
	 DeltaX:	 6.370



	 DeltaY:	 -42.550
	 DeltaZ:	 -4.800

	 Manufacturer:	 Klein
	 Model:		   5000 V2
	 Serial Number:	  

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-001 00:00

	 Comments: HSRR 2015
	 Apply Yes
	 WaterLine 0.380

	 Time Stamp:	  2015-166 00:00

	 Comments: With HSL's, after ballasting during Charleston port call. 
	 Apply Yes
	 WaterLine 0.441
_________________________________________________________



Vessel Name: TJ_S222_Klein5000_SSS200_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-001 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 
	 Model:		   Unknown
	 Serial Number:	  

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-117 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 
	 Model:		   Unknown
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-001 00:00



	 Comments: (null)
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 Applanix
	 Model:		   v4
	 Serial Number:	  (null)

_________________________________________________________
Heave Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply No
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000
	 Offset:	 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Pitch Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply No
	 Time Correction(s) 0.000
	 Pitch offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

_________________________________________________________
Roll Sensor:

	 Time Stamp:	  2015-001 00:00

	 Comments: (null)
	 Apply No
	 Time Correction(s) 0.000
	 Roll offset: 0.000

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)



_________________________________________________________
Tow Point:

	 Time Stamp:	  2015-001 00:00

	 Comments: HSRR 2015
	 Time Correction(s) 0.000
	 DeltaX:	 6.370
	 DeltaY:	 -42.550
	 DeltaZ:	 -4.800

	 Manufacturer:	 Klein
	 Model:		   5000 V2
	 Serial Number:	  

	 Time Stamp:	  2015-117 00:00

	 Comments: HSRR 2015 SSS Cert Results
	 Time Correction(s) 0.000
	 DeltaX:	 6.370
	 DeltaY:	 -42.550
	 DeltaZ:	 -4.800

	 Manufacturer:	 Klein
	 Model:		   5000 V2
	 Serial Number:	  

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-001 00:00

	 Comments: HSRR 2015
	 Apply Yes
	 WaterLine 0.380

	 Time Stamp:	  2015-166 00:00

	 Comments: With HSL's, after ballasting during Charleston port call. 
	 Apply Yes
	 WaterLine 0.441
_________________________________________________________



TJ_Z1_ASV_VB_2015.txt[9/14/2015 12:46:21 AM]

Vessel Name: TJ_Z1_ASV_VB_2015.hvf
Vessel created: September 13, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-225 00:00

	 Comments: Odom Airmar SS510 200khz 8 deg beam width
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 Odom
	 Model:		   oecv
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-225 00:00

	 Comments: remeasured after return
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.500
	 DeltaZ:	 -0.617

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

	 Time Stamp:	  2015-225 00:10

	 Comments: remeasured after return
	 Time Correction(s) 0.310
	 DeltaX:	 0.000
	 DeltaY:	 0.500
	 DeltaZ:	 -0.617

	 Manufacturer:	 Trimble
	 Model:		   SPS 361
	 Serial Number:	  



TJ_Z2_ASV_VB_2015.txt[9/14/2015 12:46:57 AM]

Vessel Name: TJ_Z2_ASV_VB_2015.hvf
Vessel created: September 13, 2015

Depth Sensor:

	 Sensor Class:	  Swath
	 Time Stamp:	  2015-225 00:00

	 Comments: Odom Airmar SS510 200khz 8 deg beam width
	 Time Correction(s) 0.000

	 Transduer #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 Manufacturer:	 Odom
	 Model:		   oecv
	 Serial Number:	  

_________________________________________________________
Navigation Sensor:

	 Time Stamp:	  2015-225 00:00

	 Comments: remeasured after return
	 Time Correction(s) 0.000
	 DeltaX:	 0.000
	 DeltaY:	 0.520
	 DeltaZ:	 -0.619

	 Manufacturer:	 (null)
	 Model:		   (null)
	 Serial Number:	  (null)

	 Time Stamp:	  2015-225 00:10

	 Comments: remeasured after return
	 Time Correction(s) 0.130
	 DeltaX:	 0.000
	 DeltaY:	 0.520
	 DeltaZ:	 -0.619

	 Manufacturer:	 Trimble
	 Model:		   SPS 361
	 Serial Number:	  



TJ_Z2_ASV_VB_2015.txt[9/14/2015 12:46:57 AM]

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2015-225 00:00

	 Comments: (null)
	 Time Correction(s) 0.000

	 Entry 0) Draft: 0.000	 Speed: 0.000
_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2015-225 00:00

	 Apply Yes
	 Comments: (null)
	 Time Correction(s) 0.000

	 Time Stamp:	  2015-231 00:00

	 Apply Yes
	 Comments: 
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: -0.001	 Speed: 0.972
	 Entry 3) Draft: 0.006	 Speed: 1.944
	 Entry 4) Draft: 0.018	 Speed: 2.916
	 Entry 5) Draft: 0.023	 Speed: 3.499
	 Entry 6) Draft: 0.014	 Speed: 3.985
	 Entry 7) Draft: -0.003	 Speed: 4.510
	 Entry 8) Draft: -0.017	 Speed: 4.996
	 Entry 9) Draft: -0.112	 Speed: 5.987
_________________________________________________________
TPU

	 Time Stamp:	  2015-225 00:00

	 Comments: 
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 0.000
		  Y Head 1 0.000
		  Z Head 1 0.000
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1
		  X Head 1 0.000
		  Y Head 1 -0.520



TJ_Z2_ASV_VB_2015.txt[9/14/2015 12:46:57 AM]

		  Z Head 1 0.619
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.000
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.150 or 0.000'' of heave amplitude.
	 Measurement errors: 0.005
	 Motion sensing unit alignment errors
	 Gyro:0.000	 Pitch:0.000	 Roll:0.000
	 Gyro measurement error: 1.000
	 Roll measurement error: 0.000
	 Pitch measurement error: 0.000
	 Navigation measurement error: 2.000
	 Transducer timing error: 0.000
	 Navigation timing error: 0.010
	 Gyro timing error: 0.200
	 Heave timing error: 0.000
	 PitchTimingStdDev: 0.000
	 Roll timing error: 0.000
	 Sound Velocity speed measurement error: 0.000
	 Surface sound speed measurement error: 0.000
	 Tide measurement error: 0.000
	 Tide zoning error: 0.000
	 Speed over ground measurement error: 0.300
	 Dynamic loading measurement error: 0.005
	 Static draft measurement error: 0.010
	 Delta draft measurement error: 0.020
	 StDev Comment: Heave uncertainty must be assessed daily. Half of the peaked trough.
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2015-225 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 SVP #2:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000



TJ_Z2_ASV_VB_2015.txt[9/14/2015 12:46:57 AM]

	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-225 00:00

	 Comments: (null)
	 Apply Yes
	 WaterLine -0.120
_________________________________________________________



TJ_Z1_ASV_VB_2015.txt[9/14/2015 12:46:21 AM]

	 Time Stamp:	  2015-230 00:00

	 Comments: New time DYNamic
	 Time Correction(s) 0.320
	 DeltaX:	 0.000
	 DeltaY:	 0.500
	 DeltaZ:	 -0.617

	 Manufacturer:	 Trimble
	 Model:		   SPS 361
	 Serial Number:	  

_________________________________________________________
Gyro Sensor:

	 Time Stamp:	  2015-225 00:00

	 Comments: (null)
	 Time Correction(s) 0.000

	 Entry 0) Draft: 0.000	 Speed: 0.000
_________________________________________________________
Draft Sensor:

	 Time Stamp:	  2015-225 00:00

	 Apply Yes
	 Comments: acquired 227 backdated 225
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: 0.010	 Speed: 0.500
	 Entry 3) Draft: 0.017	 Speed: 1.000
	 Entry 4) Draft: 0.023	 Speed: 1.500
	 Entry 5) Draft: 0.027	 Speed: 2.000
	 Entry 6) Draft: 0.027	 Speed: 2.500
	 Entry 7) Draft: 0.023	 Speed: 3.000
	 Entry 8) Draft: 0.010	 Speed: 3.500
	 Entry 9) Draft: -0.010	 Speed: 4.000
	 Entry 10) Draft: -0.030	 Speed: 4.500
	 Entry 11) Draft: -0.054	 Speed: 5.000
	 Entry 12) Draft: -0.054	 Speed: 5.500

	 Time Stamp:	  2015-225 00:10

	 Apply Yes
	 Comments: Acquired 232_backdated to 225Day 232
	 Time Correction(s) 0.000

	 Entry 1) Draft: 0.000	 Speed: 0.000
	 Entry 2) Draft: -0.003	 Speed: 0.972
	 Entry 3) Draft: 0.006	 Speed: 1.944



TJ_Z1_ASV_VB_2015.txt[9/14/2015 12:46:21 AM]

	 Entry 4) Draft: 0.000	 Speed: 2.916
	 Entry 5) Draft: -0.010	 Speed: 3.888
	 Entry 6) Draft: -0.029	 Speed: 4.160
	 Entry 7) Draft: -0.072	 Speed: 4.413
	 Entry 8) Draft: -0.162	 Speed: 5.501
_________________________________________________________
TPU

	 Time Stamp:	  2015-225 00:00

	 Comments: 
	 Offsets 

	 Motion sensing unit to the transducer 1 
		  X Head 1 0.000
		  Y Head 1 0.000
		  Z Head 1 0.000
	 Motion sensing unit to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000
	 Navigation antenna to the transducer 1
		  X Head 1 0.000
		  Y Head 1 -0.500
		  Z Head 1 0.617
	 Navigation antenna to the transducer 2
		  X Head 2 0.000
		  Y Head 2 0.000
		  Z Head 2 0.000

	 Roll offset of transducer number 1 0.000
	 Roll offset of transducer number 2 0.000

	 Heave Error: 0.150 or 0.000'' of heave amplitude.
	 Measurement errors: 0.005
	 Motion sensing unit alignment errors
	 Gyro:0.000	 Pitch:0.000	 Roll:0.000
	 Gyro measurement error: 1.000
	 Roll measurement error: 0.000
	 Pitch measurement error: 0.000
	 Navigation measurement error: 2.000
	 Transducer timing error: 0.000
	 Navigation timing error: 0.010
	 Gyro timing error: 0.200
	 Heave timing error: 0.000
	 PitchTimingStdDev: 0.000
	 Roll timing error: 0.000
	 Sound Velocity speed measurement error: 0.000
	 Surface sound speed measurement error: 0.000
	 Tide measurement error: 0.000
	 Tide zoning error: 0.000
	 Speed over ground measurement error: 0.300
	 Dynamic loading measurement error: 0.005
	 Static draft measurement error: 0.010



TJ_Z1_ASV_VB_2015.txt[9/14/2015 12:46:21 AM]

	 Delta draft measurement error: 0.020
	 StDev Comment: Heave uncertainty must be assessed daily. Half of the peaked trough.
_________________________________________________________
Svp Sensor:

	 Time Stamp:	  2015-225 00:00

	 Comments: 
	 Time Correction(s) 0.000

	 Svp #1:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

	 SVP #2:
	 -------------
	 Pitch Offset:	 0.000
	 Roll Offset:	 0.000
	 Azimuth Offset:	 0.000

	 DeltaX:	 0.000
	 DeltaY:	 0.000
	 DeltaZ:	 0.000

_________________________________________________________
WaterLine:

	 Time Stamp:	  2015-225 00:00

	 Comments: (null)
	 Apply Yes
	 WaterLine -0.120
_________________________________________________________



2015 Dynamic Draft- S222 ERDDM Documentation 
 
Introduction 
 
As a vessel increases speed through the water a high pressure area is generated at the bow and a low pressure 
area is generated at the stern. This causes the vessel to rise at the bow and settle at the stern, a phenomenon 
called settlement and squat, or dynamic draft. As speed increases, the bow will continue to rise and the stern 
will continue to squat until the vessel exceeds the threshold called planning speed, at which point the vessel 
ceases to push through the water and rises up on top of the water and more or less trims out onto a level plane. It 
is important to note that many vessels have displacement hulls, which means that they cannot reach planning 
speed, and are therefore continuously operating in their dynamic range of settlement and squat. For 
hydrographic survey vessels, it is critical to accurately measure the amount of settlement and squat (dynamic 
draft) in order to accurately account for the effects of settlement and squat in the bathymetry data.  
 
Many methods exist to attempt to measure the settlement and squat of a vessel. For the 2015 field season, 
NOAA Ship Thomas Jefferson (S222) utilized a Marinestar assisted post processed precise point positioning 
approach to determine the settlement and squat for the ship. This method is called an ellipsoid referenced 
dynamic draft measurement (ERDDM). The method utilized for the 2015 Hydrographic Systems Readiness 
Review on NOAA Ship Thomas Jefferson is described below: 
 
Method 
 
On April 27, 2015 (DN117), NOAA Ship Thomas Jefferson conducted an ERDDM in the vicinity of Virginia 
Beach in the Chesapeake Bay. 
 
The data were acquired beginning with a 5 minute dead-in-the-water (DIW) period to establish the zero point 
for the ERDDM procedure. After a 5 minute DIW, S222 began transiting at clutch ahead. This speed was 
maintained for approximately 2 minutes, and then the speed was increased by 200RPM every two minutes 
thereafter. This was continued until the ship reached full ahead. At the end of the run, the vessel stopped and 
began another 5 minute DIW period to conclude the first run. The steps mentioned above were repeated on a 
reciprocal course from DIW to full ahead with a final 5 minute DIW period. 
 
During the steps mentioned above, position and attitude data was logged using the Applanix POS/MV POSPAC 
file format. The POSPac file logged for the day was processed using Applanix POSMMS 7.1 GNSS Marinestar 
processing.  
 
Positional post processing terminated normally, creating a Smoothed Best Estimate Trajectory (SBET) file with 
reported positional accuracy. The SBET generated for this mission was free of any anomalies or errors that 
would degrade the results of the ERDDM.  
 
Processing Procedure 
 
The Pydro macro used is: ProcSBETDynamicDraft.py. First, a .zdf tide file created for this HSRR evolution  
file and associated tide (.tid) files are loaded. Then, in Pydro, select “Run Macro” from the Misc dropdown 
menu. Select the SBET file, the macro prompts the user for the data in YYYY-DDD format, and time stamp 
(this is the DN the EERDM data was collected). The macro prompts the user to select the order of polynomial 
best fit line to be used, select 3rd order. Pydro creates a series of graphs that document the output of the 
ERDDM macro.  
 
 
 
 



Results 
 
The first graph shows ellipsoid height and the associated uncertainties vs time as recorded in the POSPac data 
(see Figure 1). The second graph shows ellipsoid height vs speed and the residuals from the measurements to 2 
standard deviations. The result of post processing dynamic draft values shown in Figure 2 will be used in the 
CARIS HVF for the TPU Draft value. The third graph (Figure 3) is the speed vs delta draft table with the 3rd 
order polynomial best fit line, which will be used in the CARIS HIPS and SIPS, HVF for S222. 
 

 
 

Figure 1. Speed over Ground week seconds and ellipsoid height reference.  
 



 
Figure 2. ERDDM week seconds and ellipsoid height reference. 

 
 

 
 

Figure 3. Dynamic draft results. 



2015 Dynamic Draft- 3101 ERDDM Documentation 
 
Introduction 
 
As a vessel increases speed through the water a high pressure area is generated at the bow and a low pressure 
area is generated at the stern. This causes the vessel to rise at the bow and settle at the stern, a phenomenon 
called settlement and squat, or dynamic draft. As speed increases, the bow will continue to rise and the stern 
will continue to squat until the vessel exceeds the threshold called planning speed, at which point the vessel 
ceases to push through the water and rises up on top of the water and more or less trims out onto a level plane. It 
is important to note that many vessels have displacement hulls, which means that they cannot reach planning 
speed, and are therefore continuously operating in their dynamic range of settlement and squat. For 
hydrographic survey vessels, it is critical to accurately measure the amount of settlement and squat (dynamic 
draft) in order to accurately account for the effects of settlement and squat in the bathymetry data.  
 
Many methods exist to attempt to measure the settlement and squat of a vessel. For the 2015 field season, 
NOAA Ship Thomas Jefferson utilized an Inertially-aided post-processed kinematic (IAPPK) approach to 
determine the settlement and squat for the ship and two hydrographic survey launches (HSLs). This method is 
called an ellipsoid referenced dynamic draft measurement (ERDDM). The method utilized for the 2015 
Hydrographic Systems Readiness Review on NOAA Launch 3101 is described below: 
 
Method 
 
On March 10, 2015 (DN069), 3101 conducted an ERDDM between Craney Island and Sewell’s Point in the 
Elizabeth River, Norfolk, VA (See Figure 1).  
 

 
Figure 1. ERDDM track lines run by HSL 3101 3/10/15 near Naval Station Norfolk, Norfolk, VA. Chart 12245. 



 
 

The survey lines indicated in Figure 1 were run beginning with a 5 minute dead-in-the-water (DIW) period to 
establish the zero point for the ERDDM procedure. After a 5 minute DIW, Launch 3101 began transiting south 
at clutch ahead (800RPM). This speed was maintained for approximately 2 minutes, and then the speed was 
increased by 200RPM every two minutes thereafter. This was continued until the launch had reached maximum 
speed (~2400RPM). See Table 1 for an excerpt from 3101’s acquisition log. At the end of the run, the vessel 
stopped and began another 5 minute DIW period to conclude the first run. The steps mentioned above were 
repeated on a reciprocal course, north from DIW to max speed to complete ERDDM data acquisition. 
 

ERDDM/POS FILE ERDDM 
2015_069_3101.040 Start of test N-S @ 1725 UTC  
2015_069_3101.044 End @ 1751 
2015_069_3101.045 Start S-N @ 1756 
2015_069_3101.046 Stopped @ 1806 for NAVY frigate  
2015_069_3101.048 Start S-N @ 1816 
2015_069_3101.052 End S-N @ 1841 

Table 1. Acquisition log entry for HSL 3101ERDDM lines on DN069. 
 
During the steps mentioned above, position and attitude data was logged using the Applanix POS/MV POSPAC 
file format. The POSPac file logged for the day was processed using Applanix POSMMS 6.2 GNSS SmartBase 
Processing. Nearby Continuously Operating Reference Stations (CORS) were used as control stations for the 
mission. These stations are used to derive accurate and precise measurements of errors associated with 
ephemeris and clock data from the global navigation satellite system (GNSS), making it possible to derive 
positions and altitudes to within a few centimeters of accuracy. 
 
Positional post processing terminated normally, creating a Smoothed Best Estimate Trajectory (SBET) file with 
reported positional accuracy. PDOP was less than 3 for the duration of the mission. There were 6 or more SV’s 
in the solution for the duration of the mission. The SBET generated for this mission was free of any anomalies 
or errors that would degrade the results of the ERDDM. The SBET file was processed keeping all the 
coordinates in ITRF00 until the Export step. In Export, a Custom Smoothed SBET was created which 
transformed the positions into UTM Zone 18N with NAD83 as the Datum.  
 
Processing Procedure 
 
The Pydro macro used is: ProcSBETDynamicDraft.py. First, TCARI file and associated tide files are loaded. 
Then, in Pydro, select “Run Macro” from the Misc dropdown menu. Select the SBET file, the macro prompts 
the user for the data in YYYY-DDD format, and time stamp (this is the DN the EERDM data was collected).  
The macro prompts the user to select the order of polynomial best fit line to be used, select 4th order. Pydro 
creates a series of graphs that document the output of the ERDDM macro.  
 
Results 
 
The first graph shows ellipsoid height and the associated uncertainties vs time as recorded in the POSPac data 
(see Figure 2). The second graph shows ellipsoid height vs speed and the residuals from the measurements to 2 
standard deviations. The result of post processing dynamic draft values shown in Figure 3 will be used in the 
CARIS HVF for the TPU Draft value. The third graph (Figure 4) is the speed vs delta draft table with the 4th 
order polynomial best fit line, which will be used in the CARIS HIPS and SIPS, HVF. 
 
 
 



 
Figure 2. Speed over Ground week seconds and ellipsoid height reference.  

 
Figure 3. ERDDM week seconds and ellipsoid height reference.  

 
 



 
Figure 4. Dynamic draft result of ERDDM.  

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 



2015 Dynamic Draft- 3102 ERDDM Documentation 
 
Introduction 
 
As a vessel increases speed through the water a high pressure area is generated at the bow and a low pressure 
area is generated at the stern. This causes the vessel to rise at the bow and settle at the stern, a phenomenon 
called settlement and squat, or dynamic draft. As speed increases, the bow will continue to rise and the stern 
will continue to squat until the vessel exceeds the threshold called planning speed, at which point the vessel 
ceases to push through the water and rises up on top of the water and more or less trims out onto a level plane. It 
is important to note that many vessels have displacement hulls, which means that they cannot reach planning 
speed, and are therefore continuously operating in their dynamic range of settlement and squat. For 
hydrographic survey vessels, it is critical to accurately measure the amount of settlement and squat (dynamic 
draft) in order to accurately account for the effects of settlement and squat in the bathymetry data.  
 
Many methods exist to attempt to measure the settlement and squat of a vessel. For the 2015 field season, 
NOAA Ship Thomas Jefferson utilized an Inertially-aided post-processed kinematic (IAPPK) approach to 
determine the settlement and squat for the ship and two hydrographic survey launches (HSLs). This method is 
called an ellipsoid referenced dynamic draft measurement (ERDDM). The method utilized for the 2015 
Hydrographic Systems Readiness Review on NOAA Launch 3102 is described below: 
 
Method 
 
On March 11, 2015 (DN070), 3102 conducted an ERDDM in the vicinity of Sewell’s Point in the Chesapeake 
Bay (See Figure 1).  
 

 
Figure 1 – ERDDM track lines run by HSL 3102 3/11/15 near Sewell Point, Norfolk, VA. Chart 12245. 



The survey lines indicated in Figure 1 were run beginning with a 5 minute dead-in-the-water (DIW) period to 
establish the zero point for the ERDDM procedure. After a 5 minute DIW, Launch 3102 began transiting 
northeast at clutch ahead (800RPM). This speed was maintained for approximately 2 minutes, and then the 
speed was increased by 200RPM every two minutes thereafter. This was continued until the launch had a speed 
of 17 knots (2400RPM). At the end of the run, the vessel stopped and began another 5 minute DIW period to 
conclude the first run. The steps mentioned above were repeated on a reciprocal course, southwest from DIW to 
16.6 knots to complete data acquisition. 
 
During the steps mentioned above, position and attitude data was logged using the Applanix POS/MV POSPAC 
file format. The POSPac file logged for the day was processed using Applanix POSMMS 6.2 GNSS SmartBase 
Processing. Nearby Continuously Operating Reference Stations (CORS) were used as control stations for the 
mission. These stations are used to derive accurate and precise measurements of errors associated with 
ephemeris and clock data from the global navigation satellite system (GNSS), making it possible to derive 
positions and altitudes to within a few centimeters of accuracy. 
 
Positional post processing terminated normally, creating a Smoothed Best Estimate Trajectory (SBET) file with 
reported positional accuracy. PDOP was less than 3 for the duration of the mission. There were 6 or more SV’s 
in the solution for the duration of the mission. The SBET generated for this mission was free of any anomalies 
or errors that would degrade the results of the ERDDM. The SBET file was processed keeping all the 
coordinates in ITRF00 until the Export step. In Export, a Custom Smoothed SBET was created which 
transformed the positions into UTM Zone 18N with NAD83 as the Datum.  
 
Processing Procedure 
 
The Pydro macro used is: ProcSBETDynamicDraft.py. First, TCARI file and associated tide files are loaded. 
Then, in Pydro, select “Run Macro” from the Misc dropdown menu. Select the SBET file, the macro prompts 
the user for the data in YYYY-DDD format, and time stamp (this is the DN the EERDM data was collected).  
The macro prompts the user to select the order of polynomial best fit line to be used, select 4th order. Pydro 
creates a series of graphs that document the output of the ERDDM macro.  
 
Results 
 
The first graph shows ellipsoid height and the associated uncertainties vs time as recorded in the POSPac data 
(see Figure 2). The second graph shows ellipsoid height vs speed and the residuals from the measurements to 2 
standard deviations. The result of post processing dynamic draft values shown in Figure 3 will be used in the 
CARIS HVF for the TPU Draft value. The third graph (Figure 4) is the speed vs delta draft table with the 4th 
order polynomial best fit line, which will be used in the CARIS HIPS and SIPS, HVF. 
 

 



 
Figure 2. Speed over Ground week seconds and ellipsoid height reference.  

 

 
Figure 3. ERDDM week seconds and ellipsoid height reference. 



 
 

 
 

Figure 4. Dynamic draft results. 
 
 

 
 



Appendix II: Echo Sounder Calibration Reports 



THOMAS JEFFERSON
Multibeam Echosounder Calibration Vessel: 3101 200kHz Patch

Date Acquired: 3/16/2015 (DN075)

Processing Log

4/22/2015
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1452, 1456 0.90 1452, 1456 -0.50 1452, 1505 0.10
1452, 1456 1.00 1452, 1456 -0.40 1452, 1505 0.10
1452, 1456 1.20 1452, 1456 -0.47 1452, 1505 0.10
1452, 1456 1.20 1452, 1456 -0.50 1452, 1505 0.20

#DIV/0! 1.08 -0.47 0.13
#DIV/0! 0.15 0.05 0.05
#DIV/0! 1.08 -0.47 0.13

MRU Align StdDev gyro 0.05 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.10 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/27/2015

The secondary "Faulkes" line is to double check values from patch test.

Faulkes

Standard Deviation
FINAL VALUES

DWH

Final Values based on

Averages

112 Faulkes

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

Tyanne Faulkes

D00151CORF.zdf

K:\Yearly Reports\2015\HSRR\Processed\Tide\Preliminary\

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Roll bias                              4. Heading bias

Johnson
Anderson

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied



THOMAS JEFFERSON
Multibeam Echosounder Calibration Vessel: 3101 400kHz Patch

Date Acquired: 3/16/2015 (DN075)

Processing Log

4/22/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1413, 1416 1.00 1413, 1416 -0.55 1421, 1427 0.20
1413, 1416 1.42 1413, 1416 -0.56 1421, 1427 0.33
1413, 1416 1.30 1413, 1416 -0.55 1421, 1427 0.18

#DIV/0! 1.24 -0.55 0.24
#DIV/0! 0.22 0.01 0.08
#DIV/0! 1.24 -0.55 0.24

MRU Align StdDev gyro 0.08 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.11 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/27/2015

The secondary "Faulkes" line is to double check values from patch test.

Faulkes

Standard Deviation
FINAL VALUES

Final Values based on

Averages

112 Faulkes

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

Tyanne Faulkes

2015_075_3101.000, etc

D00151CORF.zdf

K:\Yearly Reports\2015\HSRR\Processed\Tide\Preliminary\

2015_075_master.svp

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Roll                             4. Yaw

Johnson
Stone

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied



THOMAS JEFFERSON
Multibeam Echosounder Calibration

Processing Log

4/23/2015
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw(deg)

1700, 1657 0.68 1700, 1657 -1.39 1657, 1710 -0.33
1700, 1657 0.60 1700, 1657 -1.23 1657, 1710 -0.10
1657, 1700 0.73 1657, 1700 -1.20 1657,1710 -0.40

#DIV/0! 0.67 -1.27 -0.28
#DIV/0! 0.06 0.10 0.16
#DIV/0! 0.67 -1.27 -0.28

MRU Align StdDev gyro 0.16 Value from standard deviation of Heading (yaw) offset values
MRU Align StdDev Roll/Pitch 0.08 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/27/2015Tyanne Faulkes

2015_078_3102.000

D00151CORF.zdf

K:\Yearly Reports\2015\HSRR\Processed\Tide\Preliminary

2015_078_162235.svp

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Roll Bias                             4. Yaw bias

Anderson

Averages
Standard Deviation

FINAL VALUES

Resulting HVF File Name

Final Values based on

Vessel: 3102 200kHz Patch

Date Acquired: 3/19/2015 (DN078)

113 Faulkes

Data converted --> HDCS_Data in CARIS

Johnson
walsh

Evaluators

TrueHeave applied

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order



THOMAS JEFFERSON
Multibeam Echosounder Calibration

Processing Log

4/23/2015
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1543.1546 0.65 1543.1546 -1.20 1543.16 -0.65
1606,1635 0.00 1543,1546 0.44 1543,1546 -1.16 1600,1543 -0.82

1543, 1546 0.52 1543, 1546 -1.17 1554, 1600 -0.93

0.00 0.54 -1.18 -0.80
#DIV/0! 0.11 0.02 0.14
0.00 0.54 -1.18 -0.80

MRU Align StdDev gyro 0.14 Value from standard deviation of Heading (yaw) offset values
MRU Align StdDev Roll/Pitch 0.06 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/27/2015Tyanne Faulkes

2015_078_3102.000

D00151CORF.zdf

Prelimindary

2015_078_162235.svp

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Roll Bias                           4. Yaw bias

Averages
Standard Deviation

FINAL VALUES

Resulting HVF File Name

SVP applied

Data converted --> HDCS_Data in CARIS

Walsh
Johnson

Evaluators

TrueHeave applied

Tide applied

Vessel: 3102 400kHz Patch

Date Acquired: 3/19/2015 (DN078)

113 Faulkes

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Faulkes

Final Values based on



THOMAS JEFFERSON
Multibeam Echosounder Calibration

Processing Log

4/30/2015
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency Lines Used Latency (sec) Pitch Lines Used Pitch (deg) Roll Lines Used Roll (deg) Yaw Lines Used Yaw(deg)
120_001_2027/ 2039 0.16 2027, 2039 0.07 -1.03
120_001_2027/ 2039 0.18 2027, 2039 0.12 2124, 2107 -1.10
120_001_2027/ 2039 0.10 120_001_2027/ 2039 0.08 -1.00

#DIV/0! 0.15 0.09 -1.04
#DIV/0! 0.04 0.03 0.05
#DIV/0! 0.15 0.09 -1.04

MRU Align StdDev gyro 0.05 Value from standard deviation of Heading (yaw) offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

Data converted --> HDCS_Data in CARIS

Faulkes
Johnson

Evaluators

TrueHeave applied

SVP applied

Vessel: S222 SV2 200kHz Patch

Date Acquired: 4/30/2015 Dn120

120 Johnson

Zero tide

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Roll Bias                             4. Yaw bias

Stone

Averages

Final Values based on

Standard Deviation
FINAL VALUES

Resulting HVF File Name

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order



THOMAS JEFFERSON
Multibeam Echosounder Calibration

Processing Log

4/28/2015
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency Lines 
Used Latency (sec) Pitch Lines Used Pitch (deg) Roll Lines Used Roll (deg) Yaw Lines Used Yaw(deg)

1827, 1846 0.10 1827, 1846 0.08 1955, 1936 -1.02
1827, 1846 0.10 1827, 1846 0.08 1955, 1936 -1.05
1827, 1846 0.09 1827, 1846 0.06 1955, 1936 -0.99

#DIV/0! 0.10 0.07 -1.02
#DIV/0! 0.01 0.01 0.03
#DIV/0! 0.10 0.07 -1.02

MRU Align StdDev gyro 0.03 Value from standard deviation of Heading (yaw) offset values
MRU Align StdDev Roll/Pitch 0.01 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

Standard Deviation
FINAL VALUES

Resulting HVF File Name

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

ZERO

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Roll Bias                             4. Yaw bias

Faulkes

Averages

Final Values based on

Vessel: S222 400kHz Patch

Date Acquired: 4/28/2015 Dn118

118 Faulkes

Data converted --> HDCS_Data in CARIS

Johnson
Stone

Evaluators

TrueHeave applied

SVP applied



THOMAS JEFFERSON
Multibeam Echosounder Calibration

Processing Log

4/28/2015
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency Lines Used Latency (sec) Pitch Lines Used Pitch (deg) Roll Lines Used Roll (deg) Yaw Lines Used Yaw(deg)
2223, 2239 0.20 22,232,239 0.20 2305, 2327 -0.10
2223, 2239 0.13 22,232,239 0.20 2305, 2327 -0.17
2223, 2239 0.20 22,232,239 0.22 2305, 2327 -0.06

#DIV/0! 0.18 0.21 -0.11
#DIV/0! 0.04 0.01 0.06
#DIV/0! 0.18 0.21 -0.11

MRU Align StdDev gyro 0.06 Value from standard deviation of Heading (yaw) offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

Standard Deviation
FINAL VALUES

Resulting HVF File Name

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

GPS Tide

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Roll Bias                             4. Yaw bias

Johnson

Averages

Final Values based on

Vessel: S222 ROV 400Hz Patch

Date Acquired: 4/30/2015 DN120

120 Faulkes

Data converted --> HDCS_Data in CARIS

Stone
Faulkes

Evaluators

TrueHeave applied

SVP applied



Appendix III: Position and Attitude System Reports 



Vessel:

Date: 3/2/2015 Dn: 61

Personnel:

PCS Serial # 3187

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics) MV-320, VER4, S/N3187
GPS Receivers

Primary Receiver
Secondary Receiver

Location: D M S
Approximate Position: Lat 36 51 3.90002

Lon 76 18 1.7866

DGPS Beacon Station:
Frequency: 289

Satellite Constellation (Use View> GPS Data)

Primary GPS (Port Antenna)

HDOP: 0.74

VDOP: 0.959

Sattelites in Use: 11

PDOP 1.869 (Use View> GAMS Solution)

Note: Secondary shown, identical to primary. 

POS/MV Calibration Report
Field Unit: Thomas Jefferson

SYSTEM INFORMATION
3101

Ligon, Marcum, Head

129.100.0.231

CALIBRATION AREA
Elizabeth River

Driver



Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration Baseline Vector

1.289 Two Antenna Separation (m) 0 X Component (m)

0.50 Heading Calibration Threshold 0 YComponent (m)

0 Heading Correction 0 Z Component (m)

Calibration Procedure:

Start time: 19:55

End time: 19:57

Heading accuracy achieved for calibration: 0.032

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector

1.289 Two Antenna Separation (m) -0.008 X Component (m)

0.500 Heading Calibration Threshold 1.288 YComponent (m)

0 Heading Correction -0.03 Z Component (m)

**POST PROCESSED VALUES  ARE USED IN POS VIEW SETUP

1.288
-0.001 X Component (m)

yes 1.288 YComponent (m)

yes -0.027 Z Component (m)

0.5

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name:

POS/MV CONFIGURATION

POS/MV CALIBRATION

(Refer to POS MV V3 Installation and Operation Guide, 4-25)

GAMS Status Online?

Save Settings?

Two Ant Separation

Baseline Vector

Calibration ThreshHold



The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

GENERAL GUIDANCE

SETTINGS (insert screen grabs)
Input/Output Ports  (Use Settings > Input/Output Ports)

NOTE: 



Heave Filter  (Use Settings > Heave) Events  (Use Settings > Events)

Time Sync  (Use Settings > Time Sync)

Does not exist on the POS/MV Version 4

Installation  (Use Settings > Installation)



Tags, Multipath and Auto Start  (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting  (Use Settings > Installation > Sensor Mounting)



GPS  Receiver Configuration   (Use Settings> Installation> GPS Receiver Configuration)

User Parameter Accuracy  (Use Settings > Installation > User Accuracy)

Frame Control  (Use Tools > Config)

Does not exist on the POS/MV Version 4

Primary GPS  Receiver

Secondary GPS Receiver



Vessel:

Date: 2/10/2015 Dn: 41

Personnel:

PCS Serial # 2562

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics) MV-320 Version 4
GPS Receivers

Primary Receiver
Secondary Receiver

Location: D M S
Approximate Position: Lat 36 50.43

Lon 76 16.75

DGPS Beacon Station:
Frequency: 289

Satellite Constellation (Use View> GPS Data)

Primary GPS (Port Antenna)

HDOP: 1.092

VDOP: 1.751

Sattelites in Use: 8

PDOP 1.653 (start) (Use View> GAMS Solution)

Note: Checked that Port is Primary

POS/MV Calibration Report
Field Unit: Thomas Jefferson

SYSTEM INFORMATION
HSL 3102

HSST Walsh, LTJG Anderson, ENS Perry, GVA Grains

129.100.0.231

CALIBRATION AREA
Elizabeth River

Driver

BD950  sn: 4617A68061,  v: 00252  ch: 24
BD950  sn: 4624A70252,  v. 00252  ch: 24



Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration Baseline Vector

1.531 Two Antenna Separation (m) 0.001 X Component (m)

0.50 Heading Calibration Threshold 1.531 YComponent (m)

0 Heading Correction -0.037 Z Component (m)

Calibration Procedure:

Start time: 10:41

End time: 10:24

Heading accuracy achieved for calibration: 0.029°

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector

1.528 Two Antenna Separation (m) 0.003 X Component (m)

0.500 Heading Calibration Threshold 1.528 YComponent (m)

0 Heading Correction -0.024 Z Component (m)

Two Ant Separation 1.530
x 0.005 X Component (m)

x 1.530 YComponent (m)

-0.028 Z Component (m)

0.5

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name:

POS/MV CONFIGURATION

POS/MV CALIBRATION

(Refer to POS MV V3 Installation and Operation Guide, 4-25)

GAMS Status Online?

Save Settings?

GAMS calibration was originally run on DN041, in the Elizabeth River. Post Processed GAMS was processed on DN043, and 
values entered above. Use post-processed valus in HSL 3102. 

3102_GAMS_Cal_DN041_2015.nmv

Baseline Vector

**POST PROCESSED VALUES  ARE USED IN POS VIEW SETUP

Calibration ThreshHold



The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

GENERAL GUIDANCE

SETTINGS (insert screen grabs)
Input/Output Ports  (Use Settings > Input/Output Ports)

NOTE: 



Heave Filter  (Use Settings > Heave) Events  (Use Settings > Events)

Time Sync  (Use Settings > Time Sync)

Does not exist on the POS/MV Version 4

Installation  (Use Settings > Installation)



Tags, Multipath and Auto Start  (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting  (Use Settings > Installation > Sensor Mounting)



Frame Control  (Use Tools > Config)

Does not exist on the POS/MV Version 4

Primary GPS  Receiver

Secondary GPS Receiver

GPS  Receiver Configuration   (Use Settings> Installation> GPS Receiver Configuration)

User Parameter Accuracy  (Use Settings > Installation > User Accuracy)



Vessel:

Date: 4/27/2015 Dn: 117

Personnel:

PCS Serial # 6497

IP Address:

POS controller Version (Use Menu Help > About) POS MV v5 7.92

POS Version (Use Menu View > Statistics) MV-320 ver5 
GPS Receivers

Primary Receiver
Secondary Receiver

Location: D M S
Approximate Position: Lat 37 0 42.24

Lon 75 46 36.94

DGPS Beacon Station:
Frequency: 289

Satellite Constellation (Use View> GPS Data)

Primary GPS (Port Antenna)

HDOP: 0.679

VDOP: 1.111

Sattelites in Use: 10

PDOP 1.469 (Use View> GAMS Solution)

Note: Secondary shown, identical to primary. 

POS/MV Calibration Report
Field Unit: Thomas Jefferson

SYSTEM INFORMATION
S222

Lewit, Glomb, Younkin

129.100.1.231

BD 982 SN:5409C86558
None Listed

CALIBRATION AREA
Chesapeake Bay 

Driver, VA 



Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration Baseline Vector

2.207 Two Antenna Separation (m) 0.038 X Component (m)

0.50 Heading Calibration Threshold 2.205 YComponent (m)

0 Heading Correction -0.082 Z Component (m)

Calibration Procedure:

Start time: 2039

End time: 2122

Heading accuracy achieved for calibration: 0.21

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector

2.214 Two Antenna Separation (m) 0.027 X Component (m)

0.500 Heading Calibration Threshold 2.214 YComponent (m)

0 Heading Correction 0.002 Z Component (m)

Baseline Vector

X ****POST PROCESSED VALUES 0.024 X Component (m)

X ARE USED IN POS VIEW SETUP 2.205 YComponent (m)

0.01 Z Component (m)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name:

POS/MV CONFIGURATION

POS/MV CALIBRATION

(Refer to POS MV V3 Installation and Operation Guide, 4-25)

GAMS Status Online?

Save Settings?

22_POSv7_92_MarinestarOn_GAMS_042720

22_POSv7_92_MarinestarOn_GAMS_043020



The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

NOTE: 

GENERAL GUIDANCE

SETTINGS (insert screen grabs)
Input/Output Ports  (Use Settings > Input/Output Ports)



Installation  (Use Settings > Installation)

Heave Filter  (Use Settings > Heave) Events  (Use Settings > Events)

Time Sync  (Use Settings > Time Sync)

Does not exist on the POS/MV Version 5



Tags, Multipath and Auto Start  (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting  (Use Settings > Installation > Sensor Mounting)



Primary GPS  Receiver

Secondary GPS Receiver

GPS  Receiver Configuration   (Use Settings> Installation> GPS Receiver Configuration)

User Parameter Accuracy  (Use Settings > Installation > User Accuracy)

Frame Control  (Use Tools > Config)

Does not exist on the POS/MV Version 5



Appendix IV: Sound Speed Sensor Calibration Reports 



























Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 004988 

Asset Product Type: Smart SV&P for Brooke MVP -

Calibration Type: sound Velocity 

Calibration Range: 1400 to 1550 m/s 

Calibration RMS Error: .0171 

Calibration ID: 004988 011712 139859 070115 223050 

Installed On: 

Coefficient A: 1.529555E+3 Coefficient H: O.OOOOOOE+O 

Coefficient B: -1.120026E+2 Coefficient I: O.OOOOOOE+O 

Coefficient C: 8.809000E+O Coefficient J: O.OOOOOOE+O 

Coefficient D: -6.948764E-1 Coefficient K: O.OOOOOOE+O 

Coefficient E: O.OOOOOOE+O Coefficient L: O.OOOOOOE+O 

Coefficient F: O.OOOOOOE+O Coefficient M: O.OOOOOOE+O 

Coefficient G: O.OOOOOOE+O Coefficient N: 0.000000E+O 

Calibration Date (dd/mm/yyyy): 7/1/2015 

Certified By: 

Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA 

T: +l-250-656-0771 F: +l-250-655-3655 Email: service@AMLoceanographic.com 



AML 
..,. OCEANOGRAPHIC 

Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 004988 

Asset Product Type: Smart SV&P for Brooke MVP -

Calibration Type: Pressure 

Calibration Range: 1000 dBar 

Calibration RMS Error: .0453 

Calibration ID: 004988 021407 OXElll 070115 144432 

Installed On: 

Coefficient A: -1.568855E+3 Coefficient H: -5.412054E-9 

Coefficient B: -8.337370E-1 Coefficient I: 8.890342E-9 

Coefficient C: 2.784933E-3 Coefficient J: -2.154370E-11 

Coefficient D: 1.651412E-4 Coefficient K: -1.798432E-12 

Coefficient E: 4.766264E-2 Coefficient L: 3.779060E-14 

Coefficient F: 2.482477E-5 Coefficient M: O.OOOOOOE+O 

Coefficient G: -7 .050158E-8 Coefficient N: O.OOOOOOE+O 

Calibration Date (dd/mm/yyyy): 7/1/2015 

Certified By: 

Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange ™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA 

T: +l-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com 



Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 007591 

Asset Product Type: Micro SV&P for Brooke MVP -

Calibration Type: sound Velocity 

Calibration Range: 1400 to 1600 m/s 

Calibration RMS Error: .0108 

Calibration ID: 007591131945 201783 090115 220113 

Installed On: 

Coefficient A: 7.156166E-4 Coefficient H: O.OOOOOOE+O 

Coefficient B: -7.478504E-5 Coefficient I: O.OOOOOOE+O 

Coefficient C: l.803130E-6 Coefficient J: O.OOOOOOE+O 

Coefficient D: -l.261247E-6 Coefficient K: O.OOOOOOE+O 

Coefficient E: O.OOOOOOE+O Coefficient l: O.OOOOOOE+O 

Coefficient F: 0.000000E+O Coefficient M: 0.000000E+O 

Coefficient G: O.OOOOOOE+O Coefficient N: O.OOOOOOE+o 

Calibration Date (dd/mm/yyyy): 9/1/2015 

Certified By: 

Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange ™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. VSL 5X6 CANADA 

T: +l-250-656-0771 F: +l-250-655-3655 Email: service@AMLoceanographic.com 



Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 007591 

Asset Product Type: Micro SV&P for Brooke MVP -

Calibration Type: Pressure 

Calibration Range: 1000 dBar 

Calibration RMS Error: .0793 

Calibration ID: 007591129146 OTE599 070115 122458 

Installed On: 

Coefficient A: -2.574139E+3 Coefficient H: -5.916234E-15 

Coefficient B: 1.820538E-1 Coefficient I: -1.762705E-5 

Coefficient C: -4.133096E-6 Coefficient J: 1.123850E-9 

Coefficient D: 2.932489E-11 Coefficient K: -2.388330E-14 

Coefficient E: 5.711769E-1 Coefficient L: 1.691618E-19 

Coefficient F: -3.660197E-5 Coefficient M: O.OOOOOOE+O 

Coefficient G: 8.071607E-10 Coefficient N: 0.000000E+O 

Calibration Date (dd/mm/yyyy): 7/1/2015 

Certified By: 

Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange ™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. VSL SX6 CANADA 

T: +1-250-656-0771 F: +l-250-655-3655 Email: service@AMLoceanographic.com 



Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 005340 

Asset Product Type: Smart SV&P for Brooke MVP -

Calibration Type: Sound Velocity 

Calibration Range: 1400 to 1550 m/s 

Calibration RMS Error: .0154 

Calibration ID: 005340 126551 201222 151214 223134 

Installed On: 

Coefficient A: 1.523254E+3 Coefficient H: O.OOOOOOE+O 

Coefficient B: -1.069894E+2 Coefficient I: O.OOOOOOE+O 

Coefficient C: 8.467569E+O Coefficient J: O.OOOOOOE+O 

Coefficient D: -8.479994E-1 Coefficient K: O.OOOOOOE+O 

Coefficient E: O.OOOOOOE+O Coefficient L: O.OOOOOOE+O 

Coefficient F: 0.000000E+O Coefficient M: O.OOOOOOE+O 

Coefficient G: O.OOOOOOE+O Coefficient N: O.OOOOOOE+O 

Calibration Date (dd/mm/yyyy): 15/12/2014 

Certified By: 

Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA 

T: +l-250-656-0771 F: +l-250-655-3655 Email: service@AMLoceanographic.com 



AML 
~·OCEANOGRAPHIC 

a 

Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 005340 

Asset Product Type: Smart SV&P for Brooke MVP -

Calibration Type: Pressure 

Calibration Range: 1000 dBar 

Calibration RMS Error: .0229 

Calibration ID: 

. Installed On: 

005340 127028 OTE689 151214 091044 

Coefficient A: -1.918309E+3 Coefficient H: 

Coefficient B: -1.399663E+O Coefficient I: 

Coefficient C: 2.217375E-2 Coefficient J: 

Coefficient D: -1.520440E-4 Coefficient K: 

Coefficient E: 5.851590E-2 Coefficient L: 

Coefficient F: 4.658058E-5 Coefficient M: 

Coefficient G: -9.419392E-7 Coefficient N: 

Calibration Date (dd/mm/yyyy): 15/12/2014 

Certified By: 

Robert Haydock 

President, AML Oceanographic 

1.044152E-8 

1.181616E-8 

-1.508418E-10 

8.793572E-12 

-1.896560E-13 

O.OOOOOOE+O 

O.OOOOOOE+O 

AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange ™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. VSL 5X6 CANADA 

T: +l-250-656-0771 F: +l-250-655-3655 Email : service@AMLoceanographic.com 



Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 004823 

Asset Product Type: Smart SV&T 

Calibration Type: Sound Velocity 

Calibration Range: 1400 to 1550 m/s 

Calibration RMS Error: .017 

Calibration ID: 004823 011243 139857 151214 223133 

Installed On: 

Coefficient A: 1.524941E+3 Coefficient H: O.OOOOOOE+O 

Coefficient B: -1.066587E+2 Coefficient I: O.OOOOOOE+O 

Coefficient C: 8.357867E+O Coefficient J: O.OOOOOOE+O 

Coefficient D: -8.136084E-1 Coefficient K: O.OOOOOOE+O 

Coefficient E: O.OOOOOOE+O Coefficient L: O.OOOOOOE+O 

Coefficient F: O.OOOOOOE+O Coefficient M: O.OOOOOOE+O 

Coefficient G: O.OOOOOOE+O Coefficient N: O.OOOOOOE+O 

Calibration Date (dd/mm/yyyy): 15/12/2014 

Certified By: 

Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. VSL 5X6 CANADA 

T: +1-250-656-0771 F: +l-250-655-3655 Email : service@AMLoceanographic.com 



AML l!'R OCEANOGRAPHIC 

Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 004823 

Asset Product Type: smart SV&T 

Calibration Type: Temperature 

Calibration Range: -2 to +32 Dec c 

Calibration RMS Error: .0034 

Calibration ID: 004823 030407 T12501151214 135323 

Installed On: 

Coefficient A: -4.633424E+1 Coefficient H: O.OOOOOOE+O 

Coefficient B: 2.891983E-3 Coefficient I: O.OOOOOOE+O 

Coefficient C: -4.693555E-8 Coefficient J: O.OOOOOOE+O 

Coefficient D: 4.791736E-13 Coefficient K: O.OOOOOOE+O 

Coefficient E: O.OOOOOOE+O Coefficient L: O.OOOOOOE+O 

Coefficient F: O.OOOOOOE+O Coefficient M: O.OOOOOOE+O 

Coefficient G: O.OOOOOOE+O Coefficient N: O.OOOOOOE+O 

Calibration Date (dd/mm/yyyy): 15/12/2014 

Certified By: 

Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. VSL 5X6 CANADA 

T: +l-250-656-0771 F: +l-250-655-3655 Email: service@AMLoceanographic.com 



Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 005649 

Asset Product Type: Smart SV& T Instrument, 500m Housing 

Calibration Type: Sound Velocity 

Calibration Range: 1400 to 1600 m/s 

Calibration RMS Error: .0101 

Calibration ID: 005649 002051 204120 151214 223131 

Installed On: 

Coefficient A: 7.148862E-4 Coefficient H: O.OOOOOOE+O 

Coefficient B: -7.437530E-5 Coefficient I: O.OOOOOOE+O 

Coefficient C: 4.150149E-7 Coefficient J: O.OOOOOOE+O 

Coefficient D: -1.307516E-7 Coefficient K: O.OOOOOOE+O 

Coefficient E: O.OOOOOOE+O Coefficient L: O.OOOOOOE+O 

Coefficient F: O.OOOOOOE+O Coefficient M: O.OOOOOOE+O 

Coefficient G: O.OOOOOOE+O Coefficient N: O.OOOOOOE+O 

Calibration Date (dd/mm/yyyy): 15/12/2014 

Certified By: 

Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. VSL SX6 CANADA 

T: +1-250-656-0771 F: +l-250-655-3655 Email: service@AMLoceanographic.com 



Certificate of Calibration 

Customer: NOAA - Marine Operations Center Atlantic 

Asset Serial Number: 005649 

Asset Product Type: Smart SV&T Instrument, 500m Housing 

Calibration Type: Temperature 

Calibration Range: -2 to +45 Deg c 
Calibration RMS Error: .0016 

Calibration ID: 005649 002099 400180 151214 130920 

Installed On: 

Coefficient A: -1.724760E+1 Coefficient H: 0.000000E+O 

Coefficient B: 1.629189E-3 Coefficient I: 0.000000E+O 

Coefficient C: -3.331031E-8 Coefficient J: 0.000000E+O 

Coefficient D: 7 .865438E-13 Coefficient K: O.OOOOOOE+O 

Coefficient E: -1.074224E-17 Coefficient L: 0.000000E+O 

Coefficient F: 8.065034E-23 Coefficient M: O.OOOOOOE+O 

Coefficient G: -1. 764235E-28 Coefficient N: 0.000000E+O 

Calibration Date (dd/mm/yyyy): 15/12/2014 

Certified By: 

Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 

traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this 

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated, 

please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post­

processing software that you use, if necessary. Older generation instruments may require configuration files, which are 

available for download at our Customer Centre at www.AMLoceanographic.com/support 

AML Oceanographic 

2071 Malaview Avenue, Sidney B.C. V8l 5X6 CANADA 

T: +l-250-656-0771 F: +l-250-655-3655 Email: service@AMloceanographic.com 
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